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CHAPTER 1: 1120 E-FILE

The IRS developed the Modernized e-File (MeF) system to provide a standardized format and transmission
method for e-filed returns. MeF uses XML (Extensible Markup Language) to implement all forms and schedules
in an electronic format. The IRS has structured tax return data into a series of schemas or XML documents
specifying the data elements, structures, and rules for each form, schedule, and attachment. Like paper tax
returns, MeF returns consists of a series of tax forms, schedules, and attachments required to file a complete
return.

MeF enforces a rigid structure that must be used to create e-filed tax returns. This structure is necessary and
critical to ensure tax preparation software can create an e-file return which can be transmitted to, and viewed
by, the IRS systems. In addition to formats defined by schemas, returns must also adhere to business rules that
provide a second level of validation.

The IRS has developed the XML schema rules and made them available to software vendors. Vendors are
required to use these XML schemas in developing software capable of e-filing returns. In many areas, e-filed
tax return information must be structured differently than in previously filed paper returns.

MEF SYSTEM CAPABILITIES

Some of the capabilities introduced with the MeF System include:

« Transmitters can send transmissions to the IRS at any time. The MeF system validates the transmission
file and creates an immediate acknowledgment file. At times, the MeF system is unavailable due to
maintenance or updates for next year processing.

« MeF is completely paperless. Information not defined by the IRS schemas can be included with the e-filed
return as PDF attachments. Signature requirements can be met by use of the Practitioner PIN option or by
attaching signature documents as PDF files.

o MeF supports the current and two previous years of returns (2020, 2019, and 2018).

« MeF supports integrated refund and payment options. Refunds can be electronically deposited in bank
accounts or balance due payments can be electronically withdrawn from bank accounts.

o MeF allows transmitters to send transmissions to the IRS year-round, except for a short cut-over period at
the end of the calendar year.
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2 Chapter 1: 1120 E-file
Returns and Extensions Supported by MeF

RETURNS AND EXTENSIONS SUPPORTED BY MEF

TYPE DESCRIPTION

Return US Corporation Income Tax Return
Return US Income Tax Return of a Foreign Corporation
Return US Income Tax Return for an S Corporation

Extension | Application for Automatic Extension of Time to File Certain Business Income
Tax, Information, and Other Returns

AUTHORIZATION TO PARTICIPATE IN THE E-FILE
PROGRAM

Thomson Reuters is the transmitter for e-filed returns. The tax preparer/firm is the Electronic Return Originator
(ERO). The ERO must be accepted as an Authorized IRS E-file Provider. The IRS Publication 3112
(http:/lwww.irs.gov/Tax-Professionals/e-File-Providers-&-Partners/Download-and-Read-IRS-
Publication-3112) provides definitions and procedures required for becoming an authorized IRS E-file
Provider.

A Large Taxpayer transmitting its own business return is not an Authorized IRS E-file Provider. Details for Large
Taxpayers can be found in the Section 5 of the IRS Publication 4163 (http://www.irs.gov/publirs-
pdf/p4163.pdf).

ADDITIONAL FORMS

In addition to the forms normally filed with business returns, MeF adds several other forms applicable only to e-
filed returns and extensions.

Form 8453 A scanned Form 8453 is used to sign the e-file return. The authorized return signer signs the
appropriate form. The return signer authenticates the accuracy of the return information reported on the form,
authorizes the ERO (if any) to transmit the return, and provides consent to directly deposit any refund and/or
authorize an electronic funds withdrawal for payment of federal taxes owed. If applicable, the ERO and paid
preparer also sign the form. The signed form is then scanned and attached as a PDF file to the return before
transmitting. The description of the scanned Form 8453 must be 8453 Signature Document.

The business entity should retain a copy of the signed form but it should not be mailed to the IRS.
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Additional Forms

Signature authorization is made using the following version of Form 8453 for the applicable return type:

RETURN TYPE DESCRIPTION

1120 8453-C: US Corporation Income Tax Declaration for an IRS e-file Return

1120-F 8453-I: Foreign Corporation Income Tax Declaration for an IRS e-file Return

11208 8453-S: US S Corporation Income Tax Declaration for an IRS e-file Return

Form 8879 The Practitioner PIN signature option uses Form 8879 and requires the taxpayer to use an ERO.
The taxpayer selects a five-digit Personal Identification Number (PIN) as their electronic signature. The
taxpayer can enter this PIN directly into the return preparation software, or authorize the ERO to enter the PIN.
The ERO completes the appropriate Form 8879, including the taxpayer’s PIN and the ERO’s PIN. The ERO
retains a copy of Form 8879 and provides a copy to the taxpayer. Form 8879 should not be mailed to the IRS.

Signature authorization is made using the following version of Form 8879 for the applicable return type:

RETURN TYPE DESCRIPTION

1120 8879-C: IRS e-file Signature Authorization for Form 1120

1120-F 8879-I: IRS e-file Signature Authorization for Form 1120-F

11208 8879-S: IRS e-file Signature Authorization for Form 1120S

THOMSON REUTERS
1120 E-FILE GUIDE



4 Chapter 1: 1120 E-file
IRS Supplements to this Guide

IRS SUPPLEMENTS TO THIS GUIDE

The IRS MeF system supports additional return filings not covered in this guide. This guide covers only the e-
filing of extensions, corporation returns, and partnership returns. This guide should be read in conjunction with
the following IRS publications and web sites:

Publication 3112, IRS E-file Application and Participation, containing standardized information about the
roles and responsibilities of Authorized IRS E-file Providers.

« Publication 4163, Modernized e-File (MeF) information for Authorized IRS E-file Providers for Business
Returns, provides specific requirements and procedures for e-filing of Forms 1120, 1120-F, 1120S, and
7004.

« Publication 4557, Safeguarding Taxpayer Data: A Guide For Your Business, provides information on
legal requirements to safeguard taxpayer data.

« E-file for Tax Professionals. IRS has posted additional information on how to participate in e-file,
transitional rules for partnerships and corporations required to e-file, and other informative links regarding
partnership/corporate e-file at http://www.irs.gov/for-Tax-Pros. The IRS frequently updates these sites
with FAQs, known issues, workarounds, and other MeF changes.

COMMUNICATING WITH THE IRS

The IRS e-help Desk provides assistance in support of MeF software and communication testing for corporate,
partnership, and tax exempt returns throughout the filing season. The e-help Desk also provides assistance
with e-Services registration and the IRS e-file application processes. Contact the e-help Desk at 1-866-255-
0654, or if outside the US and US Territories, 1-512-416-7750.

The MeF Status Page provides information on current system status, system maintenance or other processing
delays, and the volume of accepted returns. This site can be accessed at http://www.irs.gov/tax-
professionals/e-file-providers-partners/modernized-e-file-mef-status-page.

MeF Quick Alerts is an IRS e-mail service that provides current information regarding MeF issues. Subscribe to
MeF Quick Alerts at http://www.irs.gov/Tax-Professionals/e-File-Providers-&-Partners/QuickAlerts---
More--e-file-Benefits-for-Tax-Professionals.
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CHAPTER 2: RULES FOR E-FILE

MANDATORY E-FILE

Corporations with $10 million or more in total assets and that file 250 or more returns a year are required to e-
file Form 1120, 1120S, and 1120-F.

BUSINESS NAME CONTROL

Name Control matching is a process in MeF that checks the Employer Identification Number (EIN) and
Name Control of the corporation, partnership, or tax-exempt organization filer with the IRS’ National Account
Profile (NAP) database. Name Control mismatch is one of the most common causes for rejects of returns in
MeF. It is very important to ensure that the submitted return has the correct Name Control.

The name control is generally derived from the first four characters of the business name, but other rules exist
for names that contain special characters or other non-standard formatting.

If you are unable to determine your business name control with certainty, you can contact the Telephone
Assistance for Businesses (1-800-829-4933) and request assistance with verification of your organization's
Name Control. Click the link below for detailed information on Name Control:

CORPORATIONS:

http://www.irs.gov/businesses/corporations/using-the-correct-name-control-in-e-filing-corporate-
tax-returns?_ga=1.65873196.346284818.1478290758

ADDRESS CHANGES

The IRS accepts domestic and foreign address changes as shown by the taxpayer in the entity portion of the
parent return. If the Name or Address Change check box is selected, the entered address becomes the
taxpayer’s new official address of record. In the case of a consolidated return, the name change is effective only
for the top consolidated entity.
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FOREIGN ADDRESSES

Returns and extensions with a foreign address in the entity portion of the return can be e-filed. MeF requires
foreign countries to be identified with the two-character Foreign Country Code recognized by the US
Department of State. See IRS Publication 4163 (Exhibit 2) for a list of valid country codes.

The IRS instructions for some forms specify a foreign address must be entered with the country name using the
full country name rather than an abbreviation; however, per IRS Publication 4163, a taxpayer e-filing should
continue to use the country code for the country name. The form instructions might be updated in the future to
reflect this process for e-file.

SIGNING THE E-FILE

As with any income tax return filed on paper, an e-file income tax return must be signed by an authorized tax
return signer, the ERO (if applicable) and the paid preparer (if applicable). An authorized person must sign and
date the Declaration of Taxpayer on the applicable Form 8453 or Form 8879.

The MeF system requires taxpayers and providers to use one of the alternative signature options for signing e-
file returns. The two available options are the Practitioner PIN method and the scanned Form 8453. MeF
validates that a signature exists for each return. If the e-file return does not contain the required signatures, it
will be rejected.

Practitioner PIN Option

To use the Practitioner PIN option, the taxpayer must use an ERO. Although the Practitioner PIN option is totally
electronic, the ERO must still retain the signed Form 8879. With this option, the taxpayer and ERO are required
to sign the return with self-selecting PINs as described below. The taxpayer’s authorized person decides
whether to enter a personal PIN or to authorize the ERO to enter the PIN. The ERO prints Form 8879 and has
the taxpayer’s authorized person choose a five-digit PIN.

The following information must be included in the e-file if the Practitioner PIN option is used:

Practitioner PIN — 11 digits, with the first six digits the same as the Electronic Filing Number (EFIN)

Taxpayer PIN — Five numeric characters (cannot contain all zeros)

« Indication of who entered the PIN — The ERO or the taxpayer’s authorized person

Title — The title of an authorized person

Date — The date return is signed by an authorized person

THOMSON REUTERS
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Chapter 2: Rules for E-file
Refunds and Payments

The ERO must retain Form 8879 for three years from the due date or the IRS received date, whichever is later.
If the return was prepared for a fee, the ERO must ensure that the paid preparer also signs the return. If the
paid preparer is also the ERO, the preparer can check the Also the Paid Preparer box and does not complete
the Paid Preparer’s Use Only section. Paid preparers do not have to disclose their SSNs or EINs on the
copies they provide to taxpayers. The ERO should provide a copy of the Form 8879 to the taxpayer, but it
should not be mailed to the IRS.

Scanned Form 8453 Option

The scanned Form 8453 must be used if the taxpayer decides not to use the Practitioner PIN option. If this
option is selected, the authorized tax return signer and the ERO, if applicable, must sign the paper Form 8453.
The signed Form 8453 must then be scanned into a PDF document and inserted into the e-file return as a PDF
attachment. The scanned Form 8453 attached must be named 8453 Signature Document.

If the e-file data on a corporate income tax return is changed after the taxpayers signs the Declaration of
Taxpayer, taxpayers must sign a new declaration if the Total Income amount differs by more than $750 or
the Taxable Income amount differs by more than $700.

REFUNDS AND PAYMENTS

Refunds

Arefund can be applied to next year’s estimated tax, received as a direct deposit or paper check, or split so that
a portion is applied to next year’s estimated tax and the rest received as direct deposit or paper check.
Taxpayers who choose direct deposit must provide account numbers and routing numbers to providers for
qualified accounts. Qualified accounts must be held by financial institutions within the United States.

Payment Options

Taxpayers have several choices when paying any taxes owed on their returns.

Electronic Funds Withdrawal (EFW) The MeF Program allows a taxpayer to pay the balance due on Form
1120/1120-F/11208S tax returns or the application for extension of time to file Form 7004 by authorizing an
electronic funds withdrawal. If this payment method is chosen, the entire payment, not to exceed 200% of the
balance shown on the return, or a partial payment can be made at the time the tax return/extension form is e-
filed.

| D/‘ For Form 7004, the payment must equal the amount shown as the balance due.

THOMSON REUTERS
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8 Chapter 2: Rules for E-file
Refunds and Payments

Up to four quarterly estimated tax payments can be submitted with Form(s) 1120/1120-F/1120S.

The bank account information must be specified from which the payment should be withdrawn and the date on
which the withdrawal will be made. This allows the taxpayer to pay the balance due either as soon as the tax
return or form is processed, or schedule the payment for withdrawal on a future date that is not later than the
return's due date. For returns transmitted after the due date, the payment date must be the same as the date
the return is transmitted. Domestic corporations must deposit all income tax payments by the due date of the
return using the Electronic Federal Tax Payment System (EFTPS).

For an e-filed Form 7004, an Electronic Funds Withdrawal (EFW) can be used. If using an ERO, a Practitioner
PIN is required. If not using an ERO, then an ACH Debit Agreement Indicator must be included in the XML file.

If the EFW is authorized, an IRS Payment record must be attached to the e-file return/extension and an EFW
consent statement must be signed.

D/‘ For consolidated returns, the payment record can only be attached at the top-level return. Any
. payment attached otherwise will not be processed.

The following information is required in the payment record:

Routing Transit Number

Bank Account Number

o Account Type

Payment Amount

Requested Payment Date

o Taxpayer's Daytime Phone Number

Itis important to note that the 10-day transmission perfection period does not apply to payments. If a
submission was rejected, a return can be corrected within 10 days, and be given the received date of the
original rejected return. When a return is rejected on the due date, it is recommended that the EFW payment
not be transmitted with the return. The balance due can be paid through Electronic Federal Tax Payment
System (EFTPS) or by check or money order.

Aforeign corporation without an office or place of business in the United States and which does not bank in the
United States, cannot pay using EFW or EFTPS. These corporations must pay using checks or money orders.

Electronic Federal Tax Payment System (EFTPS) Balances due and estimated taxes can be paid year
around using the Electronic Federal Tax Payment System (EFTPS).

THOMSON REUTERS
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Chapter 2: Rules for E-file

Record Keeping and Documentation Requirements

Domestic corporations must deposit all income tax payments using the EFTPS. If the corporation expects to
have a net operating loss carryback, the corporation can reduce the amount to be deposited to the extent of the
overpayment resulting from the carryback, provided all other prior year tax liabilities have been fully paid and
Form 1138, Extension of Time for Payment of Taxes by a Corporation Expecting a Net Operating Loss
Carryback, is filed with Form 7004.

Foreign corporations who maintain an office or place of business in the United States must pay their tax as
described above for domestic corporations.

If a return is rejected, the time to make a timely payment has lapsed and a payment must still be made, the IRS
strongly encourages making the payment using a Federal Tax Deposit through the Electronic Federal Tax
Payment System (EFTPS). All business taxpayers are authorized to use EFTPS.

Payments by Check Balance due payments can be made by mailing a check. Payments do not have to be
mailed at the same time an e-file return is transmitted. For example, the return can be transmitted in January
and the taxpayer can mail the payment and voucher at any time on or before the return due date.

RECORD KEEPING AND DOCUMENTATION
REQUIREMENTS

Providers must retain the information listed below until the end of the calendar year in which the return was filed
or nine months after a fiscal year return was filed. Providers must make the records available to the IRS upon
request:

« Acopy of signed IRS E-file Consent to Disclosure Forms for taxpayers who signed using a scanned
signature Form (Form 8453).

« Acomplete copy of the electronic portion of the return that can be readily and accurately converted into an
e-file transmission that the IRS can process.

o The acknowledgment file for IRS accepted returns.
o The acknowledgment for all extensions.

Forms 8879-C, 8879-1, and 8879-S must be retained for three years from the due date of the return or IRS
received date, whichever is later.

E-filers who originate their own returns must retain all information that a taxpayer would retain for the
appropriate time period.
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10 Chapter 2: Rules for E-file

Record Keeping and Documentation Requirements

Providers can electronically image and store all paper records they are required to retain for IRS e-file. This
includes signed signature documents as well as any supporting documents not included in the electronic
record. The storage system must satisfy the requirements of Revenue Procedure 97-22, Retention of Books

and Records.
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CHAPTER 3: DIRECTIONS FOR TAXPAYERS
REQUIRED TO E-FILE

Any of these directions for corporations required to e-file can be used in the software.

FORMS ALLOWED AS PDF ATTACHMENTS

The forms listed below can be included as PDF attachments.

FORM DESCRIPTION 1120
Form 1120S, Schedule B1 Information on Certain Shareholders of an S Corporation X
Form 1128 Application to Adopt, or Retain a Tax Year X
Form 2439 (a) Notice to Shareholder of Undistributed Long-Term Capital Gains X
Form 2553 (b) Election by a Small Business Corporation X
Form 3115 (c) Application for Change in Accounting Method X
Form 4466 (d) Corporation Application for Quick Refund of X
Overpayment of Estimated Tax
Form 8283 (e) Noncash Charitable Contributions X
Form 8621 (a) Return by a Shareholder of a Passive Foreign X
Investment Co. or Qualified Electing Fund
Form 8716 (d) Election to Have a Tax Year Other Than a Required Tax Year X
Form 8832 (c) Entity Classification Election X
Form 8838 (d) Consent to Extend the Time to Assess Tax X

Under Sec 367 — Gain Recognition Agreement

THOMSON REUTERS
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12 Chapter 3: Directions for Taxpayers Required to E-file

Mixed 1120 (Insurance) Returns

(a) If filed with the return, required as XML. If received from a third party, allowed as PDF.
(b) PDF must be named and described as Form 2553.

(c) If filed with return, required as XML. If previously filed, allowed as PDF.

(d) If filed without signature, required as XML. If filed with signature, allowed as PDF.

(e) Required as XML, unless filing 10 or more returns, or if 3rd party signature is required.

MIXED 1120 (INSURANCE) RETURNS

A Mixed Return, for e-file purposes, is an 1120 consolidated tax return (the parent return is an 1120) that
includes at least one subsidiary that is either a Life Insurance company (Form 1120-L) or a Property and
Casualty insurance company (Form 1120-PC).

For Mixed Returns, Form 1120-L and Form 1120-PC subsidiary returns must be included in the XML.

Schedule M-3 is required in XML for all levels in a Mixed Return. This includes the top consolidation, each entity
(both parent and subsidiary), and the return subgroup(s) level. Additionally, a Form 8916 is required for all
Mixed Returns. Form 8916-A, Supplemental Attachment to Schedule M-3, is required to be filed for each return
(including subsidiary returns) for those entities that report any amounts for Cost of Goods Sold (COGS),
Interest Income, or Interest Expense on their returns.

INFORMATION AVAILABLE UPON REQUEST -
TRANSACTIONAL DETAIL FORMAT

Transactional data for the following forms can be submitted on a summary form in XML format as defined
below. Corporations using these optional procedures are agreeing that transactional data details will be made
available on request.

FORM DESCRIPTION

FormT Forest Activities Schedule
Schedule D Capital Gains and Losses
Form 4562 Depreciation and Amortization
Form 4797 Sale of Business Property

THOMSON REUTERS
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Chapter 3: Directions for Taxpayers Required to E-file 13

Compensation of Officers: Form 1120-E

FORM DESCRIPTION

Form 8824 Like-Kind Exchanges

Form 8873 Extraterritorial Income Exclusion

Summary format can be used when the underlying transactional data contains more than 100 lines for that
particular data type. The summary totals must be reported by data type, classification, or other grouping as
required on the form. If there are less than 100 instances of transactions by data type, classification, or other
grouping, the transactions are required to be itemized.

Summary format cannot be used to net gain and loss transactions. If an entity chooses to use the summary
format to report transactional data, gains and losses must be summarized and reported separately within each
form part.

For example, if a corporation had 500 short-term gain transactional items and 2000 short-term loss
transactional items, use of the Summary format requires the corporation to report two (2) separate totals on
Schedule D, Part 1 or Form 4797 under Short-term Gains and Losses, one for the total of the short-term gain
items and one for the total of the short-term loss items.

COMPENSATION OF OFFICERS: FORM 1120-E

Detailed information for each officer must be completed on Form 1120-E. Columns C through F are required,
while Columns A and B are optional. If a consolidated return is filed, each member of an affiliated group must
furnish this information.

Information Available on Request should not be used.

SCHEDULE E COLUMN OPTIONAL REQUIRED
(a) Name of Officer X

(b) Social Security Number X

(c) Percent of Time Devoted to Business X
(d) Percent of Stock Owned - Common X

THOMSON REUTERS
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14 Chapter 3: Directions for Taxpayers Required to E-file

Compensation of Officers: Form 1120-E

SCHEDULE E COLUMN OPTIONAL REQUIRED
(d) Percent of Stock Owned — Preferred X
(f) Amount of Compensation X

THOMSON REUTERS
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CHAPTER 4: SPECIAL RETURN TYPES

SHORT PERIOD RETURNS

In certain situations, a taxpayer might need to file a short period return before the IRS has begun accepting
returns for that year, or before software has been released for that year. In such cases, the current year
software can be used as long as the actual beginning and ending dates of the short period are used. The return
must reflect the laws applicable to the short year return even though the software being used was developed for
a prior year return.

When a short period corporate return is being filed, in some cases the regulations require the taxpayer to attach
Form 1128, provide an explanation why the short period return is being filed, or cite the applicable Revenue
Procedure.

If Form 1128 is used, attach it to the top level of the return as a PDF file and describe it as: Form 1128 for
Short Period Return.

If an explanation is required, it can be submitted in the General Dependency XML document or in a PDF file.
Provide the regulatory citation and explanation in a General Dependency PDF file with the description: Short
Period Return Explanation.

To prevent processing delays, IRS has added to the 1120, 1120S, and 1120-F schema indicators of the valid
reasons for filing a short period return. If the reason for a short period return is not listed, use the General
Dependency to indicate the reason why a short period return is being filed.

Setting Up Short Year Returns in the Tax Application

1. Select Organizer > General information > Basic Return Information > Return Information tab,
and then scroll to the Dates section.

2. Selectthe Short year return check box.

3. Enter the beginning and ending fiscal year dates. Be sure that other dates within the return are correct for
the short-year return. For example, sales of capital assets should have the correct year for date sold.

4. If applicable, also select one of the Short Year Period Indicators, such as Section 1398, from the drop-
down list on this Organizer screen.

THOMSON REUTERS
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16 Chapter 4: Special Return Types

Superseding and Amended Returns

SIGNING OFFICER

[ Do not print officer's signature date on e-file signature authorization form (Date will be included in efile only)
[ Do not print officer's signature date on the federal return (Date will be included in e-file only)
[ Officer is foreign and does not have an SSN ("888008888" will be included in e-file based on IRS instructions)

DAt MM/DD/YYYY

[ Use signature date for states

SSN (Optional). ..o

ACCOUNTING METHOD

O Cash O Accrual O Other:

DATES

] Short year return
Beginning date of next tax year after short year

Ending date of next tax year after short year........... 100/

Section 1398 Election v

(Mone selected)

National Office Grant Letter
Filed under Revenue Procedure 2006-45 or 2006-46
Notation refemring to Section 895 (c)(1)1A)

Election Change in taxable year under Section 893 (c)(2)
Section 1398 Election

Second Short Year after Section 1398 Election
Section 444 Election Terminated

Short year period indicator (e-file)....................

CHECK IF

[ Initial return
[ Final return

Figure 4:1

SUPERSEDING AND AMENDED RETURNS

The IRS accepts both superseding and amended returns for Forms 1120, 1120S, and 1120-F.

THOMSON REUTERS
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Chapter 4: Special Return Types 17

Superseding and Amended Returns

A superseding return is a subsequent return filed within the filing period (including extensions). An amended
return is a subsequent return filed after the expiration of the filing period (including extensions).

Both superseding and amended returns are required to be e-filed if the taxpayer is required to e-file the original
return.

Superseding Returns

A superseding return must be a complete XML filing of the entire return with all required forms, schedules, and
attachments (XML or PDF, if applicable). All of the business rules for e-filing original returns are enforced for
superseding returns.

Using Superseding Returns

1. Navigate to Organizer > General Information > Basic Return Information > Return Information
tab, and then select the Superseded Return option.

2. Make all necessary changes to this return.
3. The superseded return must be a complete return with all forms, schedules, and attachments.

4. Follow your normal procedures for creating, reviewing, and submitting the e-file.

Amended Returns

An e-filed amended return is similar to a paper amended return filing in that the amended return is a subset of
information from the original return. For 1120, 1120S, and 1120-F returns, the amended return should include
the main form and any changes that were made. To facilitate this for 1120, 1120S, and 1120-F amended
returns, only a subset of business rules are enforced.

THOMSON REUTERS
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18 Chapter 4: Special Return Types

Superseding and Amended Returns

Amended returns require at a minimum:.

e The corrected Form 1120, 1120S or 1120-F completed in its entirety with the Amended Return check
box selected.

« Allforms, schedules, and attachments that changed, or that support changes on the amended Form
1120, 11208, or 1120-F, including any subsidiary returns (if changed) and the information to support
those changes.

« Submit one of the following:

o For Form 1120 — Attach the XML Form 1120X completed through Part |, line 10 or 11, as applicable,
and Part Il with the line number of each amended item, the corrected amount or treatment of the
item, and an explanation of the reasons for each change.

or

o For Forms 1120S and 1120-F — Attach the XML document amended return changes that identifies
the line number of each amended item, description, amount on the previous return, amount on the
amended return, and explanation of the reasons for each change.

« Asigned signature document (Form 8453) as applicable, or use of a Practitioner’s PIN.

« Appropriate forms to make a payment, request a refund or request a credit carryover to another year.

Using Amended Returns

For amended returns:

1. Create a newreturn by selecting Save As. This creates a duplicate of the original return. In the new
return, select Organizer > General Information > Basic Return Information > Return Information
tab.

2. Check Amended Return, and do the following, as applicable:

o For 1120 returns, make all necessary changes to the corrected return, and complete Form 1120X for
inclusion in the XML file.

o For 1120S returns, make all necessary changes to the corrected return, and complete the Amended
Return Changes detail that identifies the line number of each amended item, description, amount on
the previous return, amount on the amended return, and explanation of the reasons for each
change. This detail is entered in Organizer > Amended Return > Amended Changes.

o Include an updated signed Form 8453 or Practitioner PIN information with each amended return.
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CHAPTER 5: ATTACHMENTS TO THE
RETURN

Attachments to the tax return include:
o Taxforms
o Statements
o Elections
« Notices
o Schedules

Other types of miscellaneous information that might be required by IRS form instructions or regulations

o Schedules or additional information that the preparer wants to attach to the return

These attachments can be submitted electronically as XML documents or as PDF attachments.

XML DOCUMENTS

If the IRS has defined a schema for information to be included in the return, then that information must be
provided in XML format. The types of schemas cover:

Tax Forms We automatically format, in XML, any tax form information that is included in the return.

Information Requested on Tax Form Instructions For example, a tax form line for Other Income might
include instructions to attach detail. In some cases, the schema provides specific data elements, and in other
cases the schema allows for entry of free-form text. We automatically format, in XML, this additional information
thatis included in the return.

THOMSON REUTERS
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20 Chapter 5: Attachments to the Return

General Dependency

GENERAL DEPENDENCY

The General Dependency feature allows for the submission of information that is not specified in a predefined
schema. This includes information that is requested in regulations or publications, which is not specified in form
instructions but must be included in XML format. The IRS created the general dependency schemas to provide
a method for submitting in XML other information not specifically defined by other schemas. The IRS general
dependency schemas can also be used to include information for IRS workarounds until schemas are updated.
The IRS provides three types of General Dependencies:

General Dependency Available for Form 1120, this is attached at the return level and allows for an
explanation of up to one million characters.

General Dependency (Medium) Available for Forms 1120S and 1120-F, this is attached at the return level
and allows for an explanation of up to 100,000 characters.

General Dependency (Small) Attached at the form or schedule level, this allows for an explanation of up to
5,000 characters. The General Dependency (Small) can be attached to the following forms:

o Form 851
o Form 926
o« Form 1065
e Form 1118
o Form 1118 AMT
o Form 3800
« Form 4136
o Form 4562
o Form 4684
o Form 5471
e Form5713
e« Form 6765
« Form 8586

o Form 8834

THOMSON REUTERS
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Data elements for each general dependency include:

G

Form 8865

Form 8886

Schedule M-3 (Form 1120)
Schedule M-3 (Form 1120-L)
Schedule M-3 (Form 1120-PC)

Schedule M-3 (Form 1120-S)

Business Name
Taxpayer identification number
Form line or instruction reference

Regulation reference

Chapter 5: Attachments to the Return

General Dependency

Description: A meaningful title or explanation for the attachment. The IRS uses the description as the

General Dependency title when viewing the return.

Additional information: This is the explanation with the number of characters limited by the general

dependency type.

Special Condition Description

If the requested information or election requires presentation in a columnar format, the IRS will
allow this information to be submitted as a PDF attachment.

The Form 1120, 1120S, and 1120-F schemas include a Special Condition Description that can be used to
provide information without the IRS having to update its schemas. Special conditions calling for additional
information might arise from natural disasters, late legislation, recent Revenue Procedures, and so forth. The
IRS includes when the Special Condition Description should be used in the Known Issues and Solutions file on
its Website, http://www.irs.gov/.

THOMSON REUTERS
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22 Chapter 5: Attachments to the Return
PDF Attachments

PDF ATTACHMENTS

The tax return can also include non-XML documents, known as binary attachments, submitted in PDF
format. PDF attachments allow taxpayers to provide requested documentation that includes required
signatures and third party documents as required by forms and instructions.

Each file attached to a return must contain an unique, meaningful title and description for the attachment. If the
description of the file is not representative of its contents, it can result in a delay in the return processing.

The following are examples of descriptions that can also delay processing:
o Other
o PDF Attachment
 Miscellaneous Information

The description is used to identify the attachment when the IRS displays the PDF. PDF files can be created
using any available tool, but these IRS guidelines must be followed:

Do not password protect or encrypt PDF attachments.

Keep PDF attachments as small as possible.

o If using Adobe Acrobat, avoid requiring compatibility with Adobe Acrobat versions earlier than version
8. Making the PDF file compatible with earlier versions will increase the size of the file.

o Move the compression/quality slider on Create PDF From Scanner to higher compression in order
to lower the size of the file when the source document is of decent quality and from scanner input.

Each individual uncompressed PDF cannot exceed 60 MB. The total of all uncompressed PDF files in the
return cannot exceed 1 GB.

The file name of each PDF cannot exceed 587 characters, including the file extension.
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Chapter 5: Attachments to the Return
Using the System

« The file name cannot include the following special characters:
o Apostrophe (')
o Double quotation mark (")
o Leftand right angle brackets (<) and (>)
o Vertical bar (|)
o Square brackets ([])
o Caret (")
o Ampersand (&(the and symbol above the number 7 on the keyboard))
o Slashes (/) and (\)
o Colon and semicolon (:) and (;)
o Question and exclamation marks (?) and (!)
o Asterisk (*)

o Double periods (..)

USING THE SYSTEM

All information entered to complete tax forms and supporting detail is automatically included in XML.

THOMSON REUTERS
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24 Chapter 5: Attachments to the Return
Using the System

General Dependency information applicable to the return level is entered through Organizer > Federal E-file
> Attachments > General Dependencies. The Overview screens contains links to each of the form specific
general dependencies (Small General Dependencies).

GENERAL DEPENDENCY FOR FORM 1120, 1120-L AND 1120-PC (UP TO 1 MILLION CHARACTERS)

General Dependency

MEDIUM GENERAL DEPENDENCY FOR FORM 1120-F AND 1120-S (UP TO 100,000 CHARACTERS)

Medium General Dependency

SMALL GENERAL DEPENDENCY (UP TO 5,000 CHARACTERS)

851 926 38300 4136 4562 8834
8586 4684 5471 5713 6765 8886
8938 4562 (Depletion)

ma

1118 (Domestic) 1118 AMT (Domestic)
1118 (International} 1118 AMT (International)

SCHEDULE M-3

Schedule M-3 (Form 1120) Schedule M-3 (Form 1120-S)
Schedule M-3 (Form 1120-L) Schedule M-3 (Form 1120-PC)

Figure 5:1
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CHAPTER 6: ELECTIONS

GENERAL GUIDELINES

The IRS reviewed all forms and form instructions to identify where taxpayers are required to attach supporting
data. Wherever the supporting data is located in an election, the IRS has provided specific XML
formats that must be used.

The examples below are samples of elections required by form instructions:

INSTRUCTIONS ELECTION REQUIRED

Form 1120 Dual Consolidated Losses Statement
Form 8697 De Minimis Exception Election
Form 4562 Election Not to Claim Special Depreciation Allowance

The IRS has not reviewed all regulations and publications to identify every possible election. Rather than
performing this analysis and then defining specific schemas to match each of these elections, the IRS created a
General Dependency schema.

The General Dependency schema is used for most disclosure statements and elections required by regulations
or IRS publications. The General Dependency schema includes the following elements:

Form Line or Instructions Reference (Optional) Complete this field when the election is made based on
information on IRS forms or form instructions, and the IRS has not defined a specific format.

Regulation Reference (Optional) Use this field to identify information for elections made based on
information contained in regulations or publications.

Description (Optional) Use this field to enter a brief explanation of the election.

Attachment Information (Optional) Use this field to include additional information or to reference PDF
attachments.

The current IRS schema definitions do not support information entered in a columnar format. For elections
requiring columnar format, the IRS allows these to be included in the return as PDF attachments. Separate PDF
files must be created for each election, and the regulation reference should be used in the name of the PDF file.

THOMSON REUTERS
1120 E-FILE GUIDE



26 Chapter 6: Elections

Examples of Election Formats

EXAMPLES OF ELECTION FORMATS

The examples below illustrate how elections can be formatted:

Election Not Containing Columnar Data Election data not containing columnar data must be reported
using the IRS-defined schema for that election. If no schema has been defined, then the General Dependency
schema must be used.

Regulation Reference IRC Section 172(b)(3)
Description Election to Forego Net Operating Loss Carryback

Attachment Information Pursuant to IRC Sec. 172(b)(3), taxpayer hereby elects to relinquish the entire
carryback period with respect to the net operating loss incurred in this tax year ended December 31, 2020.

Election That Applies to Multiple Subsidiaries Elections that apply to multiple subsidiaries and do not
contain columnar data must be reported using the IRS-defined schema for that election. If no schema has been
defined, then the General Dependency schema must be used.

Regulation Reference IRC Section 172(b)(3)
Description Election to Forego Net Operating Loss Carryback

Attachment information Pursuant to IRC Sec. 172(b)(3), taxpayer hereby elects to relinquish the entire
carryback period with respect to the net operating loss incurred in this tax year ended December 31, 2020, for
the following subsidiaries:

o ABC Corporation
« CDE Corporation
o EFG Corporation

Election That Contains Columnar Data Elections that require columnar data may be attached as PDF files.
Separate PDF files must be created for each election. Use the regulation reference to create the name of the
PDF file.

PDF Details IRS Section 195(b) Election to Amortize Start-Up Expenditures
Taxpayer Name ABC Corporation
Taxpayer ID Number 10-0000002

Year-end December 31, 2020
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Chapter 6: Elections 27
Using the Application

In accordance with IRC Sec. 195, taxpayer hereby elects to amortize all start-up expenditures over a period of
60 months beginning with July 1, 2020, which is the month that the active trade or business began.

The start-up expenses incurred are:

DESCRIPTION OF DATE AMOUNT
EXPENSE

Attorney Fees 02/01/2020 $321,654
Accounting Fees 03/17/2020 $34,908

Elections That Require Supporting Data Some disclosure statements and/or elections require supporting
data that cannot be entered into the General Dependency schema (that is, Plans of Merger, Plans of
Reorganization, meeting notes, etc.). The IRS allows this type of supporting data to be attached to the General
Dependency schema as a PDF file. The actual disclosure statement and/or election must be entered into the
required format, and only the supporting data may be submitted as a PDF file.

USING THE APPLICATION

The application provides several methods for entering federal tax elections. Each method for entering elections
can be completed in Organizer > Federal Tax Elections.
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28 Chapter 6: Elections
Using the Application

E-file Tax Elections
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Chapter 6: Elections
Using the Application

The E-file Tax Elections (Organizer > Federal Tax Elections > e-File Tax Elections > e-File Tax
Elections) screens are used for entering IRS Defined Elections. These elections are included in the XML file
using the specific IRS-defined schemas.

THOMSON REUTERS
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30 Chapter 6: Elections

Using the Application

IRS Defined Elections

IRS reviewed all forms and form instructions to identify where taxpayers are required to attach
glections. For these elections, IRS defined specific schemas formatted to report the election

reguirements.

Mote: IRS has indicated that these s
information in the XML portion of
under Federal Tax Elections | e-File

schemas MUST be used fo include tax election
ctronic file. You must use the Croganizer screens
fions, to enter these elections.

Election Title

Enter Election

52 - 53 Week Tax Year Election

(30 to Election

Amartization Election Statement

5o to Election

Annual Recapture Revocable Election Statement

1118, Sch J

zo to Election

Common Taxable Year Election Statement

5713

3o to Election

Cooperative Election to Allocate Credit
Among Fatrons

6478

o to Election

De Minimis Exception Election

86T - LT contracts

o to Election

Deemed Dividend Election Statement 8621 Go to Election
Defer Gain from Qualifying Electric Transmission 1120 Go to Election
Delayed Reapplication Method Election LT contracts Go to Election
Mark to Market Accounting Method Election 4797 Go to Election
Mixed Straddle Account Election Statement &721 Go to Election
Post Completion Adjustments Election LT contracts Go to Election
e A
Reduce Liabilities under Reg. Sec. 1.884-1(e)(3) 1120F Go to Election
S5BIC Election to Postpone Gain Staternent 1120, Sch D Go to Election
Securities or Commodities Held by Trader 4797 Go to Election
Simplified Marginal Impact Method Election LT contracts Go to Election
Small Ethanol Producer Credit Election 6478 Go to Election
| Ediared! ot Distritision Election Statement 1120 Go to Election
NIZU E-FILE GUIDE
Special Depreciation Allowance Elaction 4562 Go to Election
Tonnage Tax Regime Election 1120 Go fo Election




Chapter 6: Elections 31
Using the Application

Figure 6:1

Select the hyperlink (blue) in the Enter Election column to go to the specific election selected.

Predefined Elections

Many elections are included in the Organizer where you can choose those that are applicable to the return.
These elections are included in the XML file using the General Dependency schema. For example, the IRC §72
(b) election is found in Organizer > Federal Tax Elections > Predefined Elections > Code Selection 43-
174(b) > Sec 72(b).

IRC SECTION 72(B) - ELECTION TO RECOMPUTE EXCLUSION WHEN VARIABLE ANNUITY PAYMENT IS LESS THAN EXCLUSION AMOUNT
[ Include this election in the retum

Taxpayer Name........_.

Taxpayer Name (override)........
Taxpayer ID Number................
Taxpayer ID (override)..............

Yearend................ [Md/DD/YYYY

Taxpayer hereby elects pursuant to Reg. 1.72-4(d)(3)(ii) to recompute exclusion amounts for the year
and for subsequent years in reference to the variable annuity contract held with
. The following information is provided in accordance

with Reg. 1.72-4{d}{3)(iv):

(a) The oniginal annuity starting date was  t04/00/vvyY | when taxpayer was years of age.

(b) The first annuity payment from the contract in the current year was received by taxpayer on |MM/DD/¥¥YY

(c) Taxpayer's investment in the contract, adjusted fer any refund features, as onginally determined

Was
(d) The total amount received under the contract that was excluded from gross income by taxpayer prior

to this year was

Figure 6:2
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32 Chapter 6: Elections
Using the Application

Account-defined Elections

You have the ability to set up your own elections in Tax Defaults, These elections are displayed within
Organizer > Federal Tax Elections > Account Defined Elections when you open your return. Then you
can select those elections that might apply to this return.

Modifications can be made to these elections, but Account Defined elections cannot be added within the
return.

ACCOUNT DEFINED ELECTION

[ Include this election in the return
Taxpayer Name:
Taxpayer 1D Number:

Year-end: MM /DD /YYYY

Short Description (Mandatory) ...

[ Include Short Description in printed election

Electronic Filing Note: The short description MUST begin with the word "Election” to be accepted
by the IRS.

Form and Line, or Instruction Reference (Optional)

Code or Regulation Reference. ...

Election Explanation

Figure 6:3
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Chapter 6: Elections
Using the Application

Preparer-defined Elections

You can add your own return-specific elections using the Preparer-Defined Elections screen by entering a
new Short Description.

Add new Short Description

Figure 6:4
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34 Chapter 6: Elections
Using the Application

These elections are included in the XML file using the General Dependency schema.

PREPARER DEFINED ELECTION

[ Include this election in the retum
Taxpayer Name:
Taxpayer ID Number:

Year-end: M

Short Description (Mandatory) ...

[ Include Short Description in printed election

Electronic Filing Note: The short description MUST begin with the word "Election” to be accepted
by the IRS.

Form and Line, or Instruction Reference (Optional)

Code or Regulation Reference.............................

Election Explanation

Figure 6:5
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CHAPTER 7: AGGREGATING XML FILES

International forms existing in other returns can be merged into the primary corporate return XML file. The
other return could have been prepared using third party software, or could be a GoSystem Tax or
ONESOURCE return. All that is needed is a valid XML file from the other return.

This process aggregates (merges) parts of the third party XML file containing international forms with the
primary return XML file. Other parts of the third party XML file are ignored.

TYPES OF AGGREGATION

« Aggregating International Forms from Returns Created with Third Party Software (page 35)

« Aggregating Forms from International Member Returns (page 40)

AGGREGATING INTERNATIONAL FORMS FROM
RETURNS CREATED WITH THIRD PARTY SOFTWARE

Aggregating XML files begins with attaching to the primary return the XML file of the other return.
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36 Chapter 7: Aggregating XML Files
Aggregating International Forms from Returns Created with Third Party Software

1. Within the primary return, in Organizer > Federal E-file > International > Third Party XML, select the
Attach Third Party XML File button on the Third Party XML screen.

Organizer Federal E-file Internabonal Third Party XML

Organizer Tax Forms Collapse All [=]
ATTACH THIRD PARTY XML FILES

New Features B

| Anach Thied Party XML File |

Inchssion of Deferred Foreign Income

[ General Information

3 Federal E file THIRD PARTY ATTACHMENTS SUMMARY

Enalbibe Astached Thrd Party XML Fies
Sagnature Authonzabon
¢ O Anachments
* [ Intermational
Imernational Members
Thomson Rewters Inemational File

Third Pasty XML

2. Onthe Electronic Filing Attachments window, select Add.

Electronic Filing Attachments

Jurisdictics  Desoriglios Fiienams Finm Barle Mawdi fied
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Chapter 7: Aggregating XML Files

Aggregating International Forms from Returns Created with Third Party Software

3. Onthe Add Attachments dialog box, select Third-Party XML File from the drop-down list, and then

select Next.

Acdd Adtachment

ATTAC=wENT

S baTen e b

P
F ol iy
Thurd Parsy XML

Le 1 1Y

4. Select Browse for File and select the applicable XML file.

Add Attachment

ATTACHENT

Alar hemend S bon

ATTACHWENT DELERIFTION

AS faTend DhE

Tt Pty AL W
oh

i o.

Lt [ER L2
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38 Chapter 7: Aggregating XML Files

Aggregating International Forms from Returns Created with Third Party Software

5. Select Upload to attach the file.

Add Attachment
PRy ——
S PR R e Toard Party XA iy -
R
s v O

[T p——
AT P I alb

=

6. Repeat this process for each XML file to be included. Select Done when finished.

D/‘ To delete third party XML files, highlight the attachment on the Electronic Filing
- Attachments screen, and then select Delete.

Electronic Filing Altachments

Jurisdletion  Destriplies Filenase fins Bate Mosdified
Ehird Farcy. s e, WL L SS0E/EELE R DD e
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Chapter 7: Aggregating XML Files

Aggregating International Forms from Returns Created with Third Party Software

7. After attaching all the XML files, confirm that the XML attachment details are correct in the Third Party
Attachments Summary on the Third Party XML screen.

ATTACH THIRD PARTY XML FILES

Attach Third Party XML File |

THIRD PARTY ATTACHMENTS SUMMARY

Attached Third Party XML Files
COLOEY _abo. XML

Total count ..

Taotal size 975

D/‘ The attached XML file names include the locator number of the primary return.

8. The attached XML files must be validated to detect XML errors. Select the Validate Third-Party XML
File button on the Third Party XML screen.

VALIDATE THIRD PARTY XML FILES (MAMDATORY)

Vahdate Trd-Party XML Fée |

Muambssr of XML validabon e

If validation errors exist:
1. Delete the attachment.
2. Use the third-party software to correct the error.
3. Recreate a new XML file.

D/‘ The aggregation process cannot be completed if any third party XML files contain
- validation errors.

THOMSON REUTERS
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40 Chapter 7: Aggregating XML Files

Aggregating Forms from International Member Returns

For corporate returns only, the items listed below are not automatically updated during the aggregation
process. Information about these items is located in the Diagnostic Messaging section on the Third Party
XML screen. Reject diagnostics will exist until these items are checked:

« PDF files (if applicable) have been attached,
« Schedule N Questions have been answered regarding foreign forms now included in the return, and

« The foreign tax creditis correct on Form 1120, Schedule J.

DIAGHOSTIC MESSAGING

Hote: Based on the forms incheded in the third party XML, additional information may be required to complete the tax return

FORMS INCLUDED IN THIRD PARTY XML

O Form926 O Ferm 1118 O Intermational forms & &)

Mote: Checking these items removes the related diagnostic messages

] PDF attachments related to the third party XML added to this retumn

If third party MML file has PDF attachment references, attach FOF files.
Havigation: File Many - Edit - Insert - E-file Arcachments.

L] Form 1120, Schedule N completed

Schedule H details will have to be compleved with correct foreign forms.
Havigation:OrganizeriGeneral Informaticn\Questions’\Schedule K.

[J Form 1118, Schedule J completed

Schedule J derails will have to be completed with correct foreign Cax

credit ARSINT.

The aggregation of international forms is complete when creating the final e-file.

AGGREGATING FORMS FROM INTERNATIONAL MEMBER
RETURNS

ONESOURCE and GoSystem returns can be created that include only international forms. The international
forms in these returns can still be aggregated into the final primary return. Under this scenario, international
XML files (referred to as XIT files during this process) are created from corporate subsidiary returns and then
aggregated with corporate top consolidation returns or partnership returns.
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Chapter 7: Aggregating XML Files 41

Aggregating Forms from International Member Returns

Create International Forms And Designate International Member
Return

1. Using a corporate subsidiary return, complete all information necessary to generate your international
forms. When entering data for the international forms, related forms must be properly associated. For
example, a Form 8858 related to a specific Form 8865 should be entered in the correct Form 8865
Organizer folder. Any number of subsidiary returns can be used.

2. Inthe Organizer of a subsidiary return, select Federal E-file > International Member Return. Select
the check box to designate this return as an International Member Return. As a result, the XIT file
created for this return will only include information for the international forms.

DESIGNATE THIS RETURN FOR USE IN AGGREGATING INTERNATIONAL FORMS

The checkbox below should ONLY be selected if the return is to be used for aggregating international forms.
If designated as an International Member Return, only the forms listed below will be included in the e-file

created for this return. All other forms will be ignored.

%] Designate this return as an International Member Return

Only the international forms listed below will be aggregated:
Form 5471
Form 8621
Form 4858
Form 8865
Form 8886

Figure 7:1

3. Even though the international forms are prepared in these International Member Returns, the XIT files are
not created here. Instead, these XIT files will be created within a top consolidation return.
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Aggregating Forms from International Member Returns

Create XIT File in a Corporate Top Consolidation Return

THOMSON REUTERS
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Chapter 7: Aggregating XML Files

Aggregating Forms from International Member Returns

To create the International E-file (XIT file), the top consolidation return must first be enabled for
aggregation. To enable aggregation, in the Organizer of the top consolidated return:

a. Enable e-file within the Federal E-file folder.

b. Select International > Aggregation Within Same Account.

CREATE E-FILE

Create International XIT File

Date/time international XIT file created.....................

Number of validation errors._.___

Create Domestic XDM File

Dateltime domestic XDM file created ...

Number of validation errors._.___

Create Aggregated E-file

Dateltime XML file created ..
E-file StatUS ..o

Number of XML validation errors__________

[ Suppress print

Company Number Return Number

NUMBER OF INTERNATIONAL FORMS FOR EACH INTERNATIONAL MEMBER

Unqualified International Returns List

Entity Name

Total number of forms and PDF attachments.......

E-file Status 5471 8621 8858 8865 8886 PDF

Figure 7:2

c. Selectthe Enable international E-file aggregation using Thomson Reuters XIT file check

d.

box.

In the International Members List section, list each of the International Member Returns by
Locator Number. Each return must be from the same account as the top consolidation return.

G

Remember, the International Member Returns are the subsidiary returns containing

the international forms.
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Aggregating Forms from International Member Returns

2. With this top consolidation return enabled for e-file aggregation, the Create E-file screen now includes
three separate Create buttons. On the Create E-file screen shown below:

CREATE E-FILE

I Create International XIT File |

"
Dateltime international XIT file created ...

Number of validationerrors_._.______

Create Domestic XDM Fl\el

Dateltime domestic XDM file created ...

Number of validation errors........................

Create Aggregated E-file

Dateltime XML file created ...

E-file statu:

Number of XML validation errors........................ X

NUMBER OF INTERNATIONAL FORMS FOR EACH INTERNATIONAL MEMBER

[ Suppress print
Company Number Return Number Entity Name E-file Status 5471 8621 8858 8865 3836 PDF

D

Total number of forms and PDF attachments.......
Unqualified International Returns List

Figure 7:3
a. Select the Create International XIT File button to create the XIT file.

b. After the XIT file is created, review the Number of International Forms for Each International
Member section.

c. The International XIT file is now available to download for aggregation with corporate top
consolidation returns or partnership returns.
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Aggregating Forms from International Member Returns

Download International XIT File
To download the international XIT file:

1. In RS Browser, select Returns Processing > E-file > Download.

Home Returns |Returns Processing

4Efile —
Select Returns M
Batch Status
Status Report

I Download

¥ Print

! Preseason Processing

I Estimates & Extensions

¥ Import/Export

b Transfer

Move From Thomson Reuters Archive

Figure 7:4
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Aggregating Forms from International Member Returns

2. Ontheresulting Electronic Filing Download screen, select Intl - Fed International from the drop-
down list for the Jurisdiction.

Home Returns Returns Processing Admin  Reports  Support  e-Form RS

A4E file —E-file Download
Select Returns
Batch Status Account | 8321 Sort List by: Assigned To:
Status Report () Nsme  (7) Client Code (®) Preparer () Partner
4Download Year: (®) Locator () Reviewer () Group
Select Rel.umso Type: éhnd M?hch 'I‘;fh;r;en%r.ﬁ i () Manager
Zalial B O 10 O ss00 - o Location:
< :
; z”m . ) Own Qo e (Al
I Preseason Processin
. R d @ 120 O oe Login IDVGroup Mame:
b Estimates & Extensions O o1ees O 709 (AN
I Import/Export O mn
b Transfer Limit List size to | 10
Move From Thomson Reuters Archive

All states may not be currently available for download. Please refer to the Release
Notes for more information.

aurscicton [ |
Federal Return ~
Federal 7004

FED Ferm 114

Intl - Fed Domestic
Iln‘ﬂ - Fed International |

urn
AL Return
AR 1000CR Composite
AR 1000CR Composite{Addendum)
AR Return
CA Return
CO Retum
CTExt
CT Estimate 1
CT Estimate 2
CT Estimate 3
CT Estimate 4
CT Return
DE Return
FL Ext
FL Return
FL Estimate 1
FL Estimate 2
FL Estimate 3
FL Estimate 4
GA Return
1A Ext
14 Return v
1D Retum

Include FDH

Figure 7:5

3. Select Continue on the Electronic Filing Download screen after selecting the search criteria for the
top consolidation return used to create the international XIT file.
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Aggregating Forms from International Member Returns

Complete E-file: Top Consolidation Return

4. On the resulting screen, select the check box for the desired return.
Home Returns Returns Processing Admin  Reports Support e-Form RS
AE-file 1120 Returns Found in Account 8321:
Select Returns
Batch Status Select Return Taxpayer Name Client Code ELF Status Jurisdiction
Status Report
4Download ’ ™ 89481V Galaxy Conglomerated Qualified INTC
Select Returns
Baich Status 1 record returned.
b Print
} Preseason Processing | Continue I| Select All || Deselect All || Cancel || Next 10
» Estimates & Extensions
» Import/Export
b Transfer
Maove From Thomson Reuters Archive
Figure 7:6
5. Select Continue, and follow the on-screen instructions to complete the download.

Step 1: Attach International XIT File. This top consolidation return does not have to be the same return

used to create the XIT file.

1. Select Federal E-file > International > Aggregation Within Same Account. Be sure the Enable
international E-file aggregation using Thomson Reuters XIT file check box is selected.

THOMSON REUTERS
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Aggregating Forms from International Member Returns

2. Select Organizer > Federal E-file > International > Thomson Reuters International File. Then
select the Attach Thomson Reuters XIT File button.

INTERNATIONAL AGGREGATION FROM A DIFFERENT THOMSOMN REUTERS ACCOUNT

Attach Thomson Reuters XIT File

[] PDF attachments related to international files were separately added to this return
[J Form 1120, Schedule N completed

ATTACHED INTERNATIONAL XIT FILES

International XIT File Name

Totalcount.... ...

Figure 7:7
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Aggregating Forms from International Member Returns

3. Onthe resulting Electronic Filing Attachments screen:

Add Attachment

ATTACHMENT

Attachment Jurisdiction International XML file -

Federal
Federal Extension

International XML file
Third Party XML file

COR

ASSOCIATE EXISTING =

ATTACHMENT DESCRIPTION

Attachment title

CANCEL

Figure 7:8
a. Selectthe Add button.

b. Onthe Add Attachments pop-up dialog box, select International XML File from the drop-down
list.

c. Browse to and select the applicable XIT file, and click Upload.

d. Onthe Electronic Filing Attachments screen, the uploaded file will appear in the attachments list.
Select Done.

4. After attaching the XIT files, confirm that the XIT attachment details are correct in the Attached XIT File
Name section.

| D/‘ The attached XIT file names will include the locator number of the primary return.
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Aggregating Forms from International Member Returns

Step 2: Create Domestic XDM File. Adomestic XML file (referred to as an XDM file during this process)
must now be created that includes all other information from the consolidated group. The domestic XDM file
includes all forms from the parent and each subsidiary. After consolidation, complete all other e-file steps,
including the review of reject diagnostics.

On the Create E-file screen, this time, select the Create Domestic XDM File button.

CREATE E-FILE

Create International XIT File

Dateftime international XIT file created ...

Number of validation errors................_............_......

Create Domestic XDM File

Dateftime domestic XOM file created..__......___.__.

Number of validation errors...._......._.._........._......

Create Aggregated E-file

Dateftime XML file created.........._____......__
Efile status.... .

Number of XML walidation errors._............................

Figure 7:9
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Chapter 7: Aggregating XML Files

Aggregating Forms from International Member Returns

Step 3: Create Aggregated E-File. The final step combines the International XIT files and the Domestic XDM
file into one.aggregated XML file ready for submission to the IRS.

On the Create E-file screen, select the Create Aggregated E-file button.

CREATE E-FILE

Create International XIT Filel

Date/time international XIT file created.

Mumber of validation errors......._. ...

Create Domestic XDM File

Dateltime domestic XOM file created ...

Number of validation errors.

I Create Aggregated E-ﬁlell

Dateltime XML filecreated...._______.._

E-file status.

Number of XML validation ermors............cocooeeeienn

Figure 7:10
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CHAPTER 8: STEPS TO E-FILING A RETURN

These steps apply to e-filing the return and extension, unless specifically noted:

1. Enable e-file. (See Enabling E-file (page 53).)

2. Select a signature authorization method. (See Signature Authorization (page 55).)

3. Review PDF attachments: (See Attachments (page 58))

« General Dependency (See General Dependency (page 63))

« International Form Attachments (See International Form Attachments (page 65))

4. Review additional information specific to this e-file return. (See Additional Information (page

66).)
5. Check for errors by generating a validation file. (See Error Checking (page 66).)

6. Create the e-file. (See Creating the E-file (page 68).)

7. Review the status of the XML file. (See Reviewing the Status of the XML File (page 69).)

8. Check the e-file history. (See Checking the E-file History (page 70).)

9. Transmit the e-file. (See Transmitting the E-file (page 71).)

10. Check the e-file status. (See Checking the E-file Status (page 72).)
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Enabling E-file

ENABLING E-FILE

1. Inthe Organizer, select the Federal E-file (or Federal E-file Extension) folder.

Organlzer Tax Forms

QuickTrack
QuickForm
Partner Allocations Enabled
» [ General Information
i~ [0 Federal E-file
Enable E-file
Signature Authorization
* [ Attachments
* [ International
* [ Additional Information
Error Checking
Create E-file
Status
History
+ [ Federal E-file Extension

+ [ Partner Information

Figure 8:1

2. Select Enable (or Enable Extension).
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Chapter 8: Steps to E-filing a Return

3. Onthe Enable E-file screen, all three substeps (a, b, and c( are required:

Enabling E-file

EMNABLE E-FILE

| [ Enable federal e-file _

(1 Suspend federal e-file

Electronic filing identification number (EFIN)............
TYPE OF ORIGINATOR

OERCO O Large taxpayer O Mot applicable

Figure 8:2

a. Selectthe Enable Federal E-file check box. Selecting the Suspend federal E-file check box
allows qualified e-files to be created, but prevents the return from being displayed as a return that

can be submitted.
b. Enter the Electronic Filing Identification Number (EFIN).

c. Select the option for the Type of Originator: ERO or Large Taxpayer.

THOMSON REUTERS
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Signature Authorization

SIGNATURE AUTHORIZATION

THOMSON REUTERS
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On the Signature Authorization screen:

SIGNATURE OPTION

O Form 8879 - Practiioner PIN
) Form 8453 - scanned signature document

O Not applicable

IF "FORM 8879 - PRACTITIONER PIN" I5 SELECTED

PIN ENTERED BY

) General partner of LLC member
O ERO
O Mot applicable

PIN INFORMATION

] Randomly generate general pariner or LLC PIN

[] Use first 5 numbers of firm EIN as ERO PIN

General partner or LLC member PIN...................

ERO PIN. e

Figure 8:3

Chapter 8: Steps to E-filing a Return 56

Signature Authorization

D/‘ The Signature Authorization screen for federal e-file extensions appears different but
. requests much of the same information.
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Signature Authorization

REQUIRED BY FORM B8B78-A

PIN ENTERED BY

O Authorized Person
O ERO
O Not applicable

IF "AUTHORIZED PERSON" IS SELECTED

NAITIE. e
T e
PRONE .

OR
Fareign phone......

Email .o

Date PINwas entered. ... M{/DD/YYYY

IF "ERO" IS SELECTED

Electronic Filing ldentification Number (EFIN)......_..
Fimmame. ...

Signature date.............ee [MM/ DD/ YYYY

PIN INFORMATION

[[] Randomly generate officer and ERO PIN

[ Use first 5 numbers of firm EIN as ERO PIN
Authorized persons PIN..._..._.............

Figure 8:4

2. Inthe Signature Option section, select either the Form 8879 Practitioner PIN or the Form 8453
scanned signature document option.

3. Ifthe Form 8879 - Practitioner PIN option is selected, complete the additional information to create the
PINs in the PIN Entered By and PIN Information section by selecting the appropriate option button and
check boxes.
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Attachments

ATTACHMENTS

An attachment is additional information that can be included in the e-file as part of the XML file, or included as a
separate PDF file. Elections are also included in the XML file. An election containing columnar data can be
attached as a separate PDF file.

PDF File Attachments

Follow these steps to attach PDF files:

1. Goto Federal E-file > Attachments > PDF Attachments > Summary screen, and select the Attach
PDF button.

HELP

Attachments Overview

ATTACH PDF

Attach PDF |

PDF ATTACHMENTS SUMMARY

] Suppress print of attachment list
Attached PDF Files

~

Figure 8:5
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Attachments

2. The following Electronic Filing Attachments screen is displayed:

Electronic Filing Attachments

Jurisdiction Deacription

Filename

Size

Date Modified

ADD

Figure 8:6
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Attachments
3. Onthe Electronic Filing Attachments screen, select Add to add a new attachment.
Add Attachment
ATTACHMENT
Attachment Jurisdiction: Federal -
OR

ATTACHMENT DESCRIPTION
@:‘ Predefined description: 8453 Signature Document -
O User defined description:

CANCEL

Figure 8:7

4. Onthe Add Attachment pop-up screen, select the Attachment Jurisdiction from the drop-down list
that applies to this attachment. Select Next.

5. The next dialog box allows you to browse to the location of the desired PDF file. Highlight the PDF file, and
then select Open.

6. The Add Attachment to Federal Return pop-up screen displays information about the selected
attachment. You must now select a meaningful title for the attachment. Either you can elect one of the
listed titles by selecting the IRS predefined description option, or enter your own User defined
description. The default user-defined title is the file name, without the extension. After selecting either
option, select Finish.

The IRS has created lists of recommended names and descriptions for PDF attachments at
http://www.irs.gov/Tax-Professionals/e-File-Providers-&-Partners/Recommended-Names-and-
Descriptions-for-PDF-Files-attached-to-Modernized-e-File-MeF-Business-Submissions.

7. Apop-up dialog box confirms the Afftachment successfully added. Select OK.
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Attachments

8. The selected PDF file now appears in the Electronic Filing Attachments window showing the selected
jurisdiction, attachment title (description), file name, file size, and date modified. Select Done to complete
the attachment.

9. The details for each PDF attachment are displayed below the Summary screen. The name of the
attached file should appear under that file folder. Details for each PDF attachment are presented on a
separate detail screen.

Forms Allowed as PDF Files

The IRS allows attachment of certain forms as PDF files instead of requiring the forms to be included in the XML
file. Navigate to Organizer > Federal E-file > Attachments > PDF Attachments > Additional
Information > Forms Allowed as PDF tab.

These forms listed in the PDF Attachments section can be attached as PDF files without meeting any other
requirements. If using this option, by checking the applicable boxes, the form is prevented from inclusion in the
XML portion of the e-file. Also, they must use the predefined titles from the PDF attachment dialog.

Ifinformation has been entered in Organizer for any of these forms, but you intend to attach the form as a PDF
file, select the check box(es) to prevent those forms from being included in the XML file.

Transactional Data

The IRS allows summary data to be reported for the following forms:

Form T: (Timber) Forest Activities Schedule

o« Form 4562: Depreciation and Amortization

Form 8873: Extraterritorial Income Exclusion
o« Form 4797: Sale of Business Property

Schedule D: Capital Gains and Losses (1120 and 1120S).
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Attachments

Go to Organizer > Federal E-file > Attachments > PDF Attachments > Additional Information >

Transactional Data tab.

SUMMARY FORMAT FOR TRANSACTIONAL DATA

Transactional data for the following forms may be submitted on a summary form in XML format. Transactional
data summary format can only be used when the underlying transactional data includes more than 100 lines for
that particular data type by form part. Data type can be aggregated across all entities to determine if the 100 line

test is met for a particular form.

Form T - (Timber) Forest Activities Schedule
Form 4562 - Depreciation and Amortization
Form 8873 - Extraternitorial Income Exclusion
Form 4797 - Sale of Business Property

Schedule D - Capital Gains and Losses (1120 and 1120S)

SUMMARY TOTAL FROM ALL FORM 8824 - LIKE-KIND EXCHANGES

Summary format can be used if there is more than one like-kind exchange transaction.

Recognized gain (Part 1], Line 23 ).
Basis of like-kind property received (Line 18 + Line 23 - Ling 15}

Figure 8:8

Follow the hyperlink (boxed in red) for each of the five forms to access the screen where you can enter the

transactional data.
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Attachments

General Dependency

A General Dependency is used for the submission of information that is not specified in a predefined schema.
For each form that allows attachment of a general dependency, the Overview screen displays links to access
general dependency information. Select a link to access a specific item.

GENERAL DEPENDENCY FOR FORM 1120, 1120-L AND 1120-PC (UP TO 1 MILLION CHARACTERS)

General Dependency

MEDIUM GENERAL DEPENDENCY FOR FORM 1120-F AND 1120-5 (UP TO 100,000 CHARACTERS)

Medium General Dependency

SMALL GENERAL DEPENDENCY (UP TO 5,000 CHARACTERS)

651 926 3800 4136 4562 8834
6586 4684 5471 5713 6765 A8E6
§938 4562 (Depletion)

ms

1118 (Domestic) 1118 AMT (Domestic)
1118 (International) 1118 AMT (International)

SCHEDULE M-3

Schedule M-3 (Form 1120) Schedule M-3 (Form 1120-5)
Schedule M-3 (Form 1120-L) Schedule M-3 (Form 1120-PC)
Figure 8:9

Attachments Included in the XML File

The General Dependency schema is used to include information at the return level for Form 1120. The
General Dependency — Medium is used to include information at the return level for Forms 1120-F and
1120S. The General Dependency — Small is used at the form level of all return types for the following forms:

e Form 851

o Form 926
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e Form1118

o Form 1118 AMT

« Form 3800

o Form 4136

o Form 4562

o Form 4684

o« Form 5471

e Form 5713

« Form 6765

o Form 8586

o Form 8834

o Form 8865

o Form 8886

o Form 8938

o Schedule M-3 (Form 1120)
o Schedule M-3 (Form 1120L)
o Schedule M-3 (Form 1120PC)

o Schedule M-3 (Form 1120S)

General Dependency at the Return Level

To add a General Dependency:

1. Select Attachments > Add General Dependency.

2. Select Add new Description.

Chapter 8: Steps to E-filing a Return

Attachments

64
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Attachments

3. Inthe Add new Description dialog box, add a description in the field provided. An unlimited number of
general dependencies can be added. Select OK to close.

4. Based on the return type, this information is automatically included in the XML file using the correct
general dependency schema.

GENERAL DEPENDENCY DETAIL

Business Name. ...

Business Name (cont'd)..... ..

ID TYPE

O EN O Appliedfor O Foreign O Not applicable

Description............
Description {Conmt'd ).
Form line / instruction reference.............c.cees
Form line / instruction reference (cont'd)....................
Requlations / publications reference. ...

Requlations / publications reference (cont'd).._........_.

ATTACHMENT INFORMATION

Number of characters. ...

Maximum number of charactars.._ ..

Figure 8:10

International Form Attachments

See Aggregating International Forms from Returns Created with Third Party Software (page 35) for
more information on international forms.
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Additional Information

ADDITIONAL INFORMATION

Navigate to Organizer > Federal E-file > Attachments > Additional Information for details on the
following items:

o Forms Included in E-file Shows a listing of every form that is included in the e-file based on conditions
existing in the return. However, the forms included in the e-file cannot be changed on this screen.

« Business Name Control Shows the system generated Name Control used by the IRS in conjunction
with the taxpayer's EIN.

« Signature Documents Shows links to the tax form documents based on the signature authorization
option.

« Foreign Entity Identification Appears only on top consolidation returns.

« Special Conditions Allows a description of a special condition that is included with the return.

ERROR CHECKING

Before a qualified e-file can be created, all e-file errors must be cleared.

Types of E-file Errors

Reject Diagnostics Reject diagnostics identify conditions in the return, which result in an IRS rejection for
failure to meet IRS Business Rules. Reject diagnostics also identify many of the common conditions that can
result in an XML validation error. The conditions generating the reject diagnostic must be corrected before a
qualified e-file can be generated.

Alert Diagnostics Alert diagnostics might also be present. While Alert diagnostics do not prevent the creation
of a qualified E-file, the conditions causing these diagnostics should still be investigated since they can reveal
input errors.

XML Validation Errors Data that does not meet the strict schema formatting requirements of the IRS
schemas result in XML validation errors. Reject diagnostics and XML validation errors are displayed within a
return in the View > Diagnostics menu.
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Error Checking

Clearing Reject Diagnostics

With e-file enabled, reject diagnostics are generated whenever conditions within the return fail to meet IRS
business rules, or when conditions exist that lead to the most common validation errors. Since reject
diagnostics can be generated at any time when the return data is changed, frequent review of the diagnostics
during the return preparation process should make creating a qualified e-file less time-consuming.

Review reject diagnostics in the View > Diagnostics menu. For most diagnostics, selecting on the diagnostic
description should take you to the source fields that need attention. Where this GoTo functionality is not
available, the steps for navigating to the source fields should be listed in the diagnostic description.

Correcting XML Validation Errors

XML errors are identified when an e-file is created. But prior to creating this e-file, perform error checking by
generating a validation file. This allows you to select each error and be taken to the source of the error.

On the Error Checking screen, select the Generate Validation File button. Once the validation file is
completed, the Number of validation errors field indicates if any XML errors exist. If errors exist, use the View >
Diagnostics menu to access the validation errors with GoTo functionality enabled.

E-FILE ERROR CHECKING

Generate Validation File

Note: This feature generates drill down/go-to functionality from view |diagnostics| e-file validation errors to the location of the error in the organizer.

E-filestatus.. ..
Dateftime XML validation file created .
Mumber of XML validation errors.............cc.ooooioee

Fillemame. ... .

Figure 8:11
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Creating the E-file

The XML file created during error checking is not transmitted to the IRS. selecting the validation error
takes you to the source of the error, using GoTo functionality. This can be either a Tax Form or an
Organizer field. However, if itis a Tax Form field, you should hyperlink to the applicable Organizer field
and correct the input.

The XML validation errors listed in the View > Diagnostics menu are not updated until the XML file is re-
created.

A single input problem can often generate multiple XML errors. Correcting the cause of one error can
automatically correct other errors.

There might be some XML validation errors where the GoTo capability does not function.

CREATING THE E-FILE

1.

2.

3.

Select Organizer > Federal E-file > Create E-file.

68

CREATE E-FILE

Create Federal E-filz

Dateftime XML file created_
Efilestatus. .

Mumber of XML validation errors.._.......................

DELETE E-FILE

Delete Federal E-file

Figure 8:12
Select the Create E-file button.

An XML file is created. When completed, a date/time stamp is displayed and the e-file status is given. If the
return contains a reject e-file diagnostic or XML validation errors, the e-file status section displays a
message stating that the XML file was created, but is not qualified to be e-filed.
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Reviewing the Status of the XML File

4. The reject diagnostics and XML validation errors must be cleared and the XML file is re-created.

5. Selectthe Delete Federal E-file button to delete an existing federal e-file.

Possible E-file status Statements

The possible status statements that can be displayed in the E-file Status section are:

o Created, but Not Qualified: The e-file (or extension e-file) has been created for viewing, but cannot be
transmitted until the reject diagnostics and XML validation errors are corrected.

« Qualified: E-file return (or extension) can be transmitted.

« Sent, Started, Transmission, or Waiting: Each of these statuses indicates that the e-file return is being
processed. The e-file cannot be recreated while the return shows this status.

« Rejected: The return has been rejected by IRS (or state authority). The condition causing the reject
should be corrected and the e-file recreated and retransmitted.

o Accepted: The IRS (or state authority) has accepted the return.

REVIEWING THE STATUS OF THE XML FILE

The Status screen displays specific details for the XML file including status, date/time stamp, validation error, if
any, file name and size, and inclusion of direct debit indicator.

E-FILE STATUS

E-file status. ...
Dateftime XML file created..... ...
Number of XML validation ermors. .........cccoccvvveveceenees
File name.........
File SIZe. .o

Direct debit indicator included in e-file.....................

RETURN ACKNOWLEDGMENT

Taxable income per IRS acknowledgment........._.

R Ao e o —

Figure 8:13
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Checking the E-file History

IRS Acknowledgment link: If the e-file has been submitted, select the IRS Acknowledgment link to display
details returned by the IRS in the acknowledgment.

CHECKING THE E-FILE HISTORY

The History folder includes the Create E-file Details tab, which displays the history of the e-file created, and
the Delete E-file Details, which displays similar detail information for any e-files that might have been deleted.

E-FILE CREATE DETAIL

Figure 8:14
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Transmitting the E-file

TRANSMITTING THE E-FILE

The next step in the process is to submit the return to the IRS through the browser menu. To file the Qualified
return or extension, exit the return, and do the following steps in RS Browser:

1. Select Returns Processing > E-file > Select Returns.

Home Returns |RE'CLI rns Processing | Admin Reports Support e-Form RS
AE file —Create E-file Batches
Select Returns
Batch Status Account | 8321 Sort List by: Agsigned To:
Status Report (®) Name () Client Code (®) Preparer () Partner
b Download | Year. O Locator (O Reviewer () Group
Type: And Match These First Manager
i Characters of Sort Column: O
I Preseason Processing O qpe0 O ssmo Location:
I Estimates & Extensions Os Qs (Al
¥ Import/Export ® 1o Owme Legin 1D/Group Mame:
b Transfer Ouwes O 7o — Suppert Firm (AN
Move From Thomson Reuters Archive O
Limit List size to | 10 .
Calort Raf: TE x4 r'-l(:ﬁh-""o:‘_
Display Type: Regular Display[¥]
e-File Type:  Return
El Federal ready to send
[0 statesicities resdy tosend Al Stztes/Cities
Select Federal or States ready fo send check box fo enable Continue button
I Continue I | Cancel | | Help |
This process will initiate electronic filing with the appropriate taxing authority. If
you need to download the actual electronic file (certain return types only).
please select "Download” from the left hand menu
Figure 8:15

2. Onthe Create Electronic Filing Batches screen, select an Account, Year, Return Type, and Sort
criteria.

3. Select the appropriate Display Type from the drop-down list.
D/‘ The Display drop-down list should have the Regular Display selected unless you are
. creating a batch for New York consolidated returns.
4. Selectthe appropriate E-file Type from the drop-down list, such as All E-File Types.

5. If applicable, select the check box for Federal Ready to send and/or States/Cities Ready to send.
The drop-down list can be used to select a specific jurisdiction.
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Checking the E-file Status

6. Select Continue and the Returns Found in Account screen is displayed.

1120 Returns Found in Account 8321: Federal
When you select a return, we will send the federal return to IRS. Mo state returns will be sent even if they are qualified
10 records returned.
All select Return Juris Abbr. Juris Description Taxpayer Name Client Code E-File Status Direct Debit In Return
[0  so3sis FED Federal BRMS Test 8 BRMS Test Bank Qualified-Lock Required N
| O S037IR FED Federal BRMS Test 9 BRMS Test Bank Qualified-Lock Required N
] ] 89481V FED Federal Galaxy Conglomerated Qualified Y
E BA74AIV FED Federal ‘Galaxy Industries, Inc. Qualified Y
D D EEETS FED Federal LEGACY SUPPLY CHAIN HOLDINGS INC SBT Qualified N
O O 2981w FED Federal Mavericks Store kdo Qualified N
0 [0 18 FED Federal MOTOR CARRIER CORPORATION tr Qualified N
1 ] 78501V FED Federal MSDA NUMBER ONE, INC. Qualified N
] | 63421V FED Federal Mew York S-Corp all lines print test========q Qualified N
D D 2386IU FED Federal NJ CET 100 Rule (150) Testing VTRAN_NI Qualified N
Submit For E-File Select All Deselect All Cancel Next 10
Figure 8:16
7. Select the check box by the return(s) you want to submit.
8. Select the Submit For E-file button.
9. The Efile File Status for Batch is displayed showing the file status.
EFILE ELF Status for Batch ID 74891: y
Return Taxpayer Name Client Code Alerts Jurisdiction Juris Description Service Center Filing Status Dat/ IC WIP Status
84741V Galaxy Industries, Inc. FED Faderal Electronic filing process started ’ wipz
1 record returned.
Refresh Cancel ’
Y

Figure 8:17

CHECKING THE E-FILE STATUS

Once the return is e-filed, Thomson Reuters receives an acknowledgment from the IRS and other taxing
authorities that the return was filed. There are two methods for viewing the status of your returns: Batch

Status or Status Report.
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Checking the E-file Status

Batch Status

1. Select Returns Processing > E-file > Batch Status.

2. Onthe Batch Status screen, select the User. Enter the Date Batch Submitted dates, Tax Year, and
select the Return Type.

3. Select the Continue button.

Home  Returns IReturns Processingl Admin  Reports Support  e-Form RS

4E-file —Batch Status
Select Returns
Batch Status User:
Status Report
! Download Date Batch Submitted

¥ Print

} Preseason Processing From (MMDDAYYY) 127/

I Estimates & Exiensions To (MMDDYYYY) 12/7/
P Import/Export
Tax Year: ~
I Transfer All Years
Move From Thomsen Reuters Archive Return Type: All

Figure 8:18

4. Selectthe Batch ID link.

E-file Batches Found:

Date/Time |Tax Year| Tax Type| Item5| Batch ID
|2016 [1120 [1 |7a891

1 batch found.

Figure 8:19
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Checking the E-file Status

5. The Efile File Status for Batch is displayed.

EFILE ELF Status for Batch ID 74891:

Return Taxpayer Name Client Code Alerts Jurisdiction Juris Description Service Center Filing Status Da
84741V Galaxy Industries, Inc. FED Federal Electranic filing process started

TC WIP Status
wip2

1 record returned.

| Refresh || Cancel |

oA A AU

Figure 8:20

Status Report

1. Select Returns Processing > E-file > Status Report.

2. Enter the applicable search criteria, e-file type, status using the drop-down list selections, and dates.

AEfile
Select Returns. E-file Status

Batch Status

Status Report
» Download
L
¥ Print

¥ Preseason Processing

[ ( assigned To:

r ——— Sort List By:
Account: | 8321 M

() Name () Client Code

vear: (7] @ Locator

» Estimates & Extensions Tax Type: Add Match These First () Manager
~ . Characters of Sort Column

» Import/Export O 1040 O 5500 Location

) Transfer

© 141 O 990 @y -

Move From Thomson Reuters Archive @120 O 708

) 1065 ) 709 Login ID/Group Name:
Q an (@i -
Limit Size To: [ 10 M
A ~ ~
E-File Type:  (*) Regular () Extension (L) All E-File Types

Always Show Lecator Information: [ |

Export to Excel: ] -
Federal Status: IReadyto. d v‘

State Status: IResdy to Send = ‘

Batch Status

Use this Scraen to make selections for generating & report that will show you the current
status of returns that you have electronically filed. If seeking a Federal e-Filing status only,
State Status should be set to “Ignore State Status". If seeking & State e-Filing status
only, Federal Status should be st to “Ignore Federal Status”,

e e W R s et R TWIE W S T

Figure 8:21

3. Ifyou select the Batch Status button, a Batch Status screen is displayed. Enter the appropriate dates,
and select Continue.

4. The Electronic Filing Batches screen and the Efile File Status for Batch screens are displayed.
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Checking the E-file Status

5. Selectthe Export Report to Excel check box if you want to export the report file as a spreadsheet. You
can also export the report to PDF format.

6. Selectthe Continue button to display the status report.

Export Report To PDF | Export Report To Excel
1120 Returns Found in Account 8321
Total Record Count : 53 Report Date:
iz indicator ix an acknowledgement that the jurisdiction has received direct debit information. Plesse nate that not al jurisdi i th

% - Fedaral Only

Locator  Tax Type  Taxpayer Name Client Code Alerts  Juris Abbr.  Juris Description E-File Status Federal Service Center  Date Sent

1120 | Galaxy Conglomerated reo Federal -

s03v |1120 BRMS Test & BRMS Test Bank FeD Federal

s0321s | 1120 BRMS Test 6 - Parent BRMS Test Bank L Tlinois - Lack Required

s031s |1120 BRMS Test 8 BRMS Test Bank FeD Federal red

037R | 1120 BRMS Test 9 BRMS Test Bank FED Federal

9037IT | 1120 BRMS Test 10 BRMS Test Bank FED Federal

11910 | 1120 TOPCON NAME AL Alabama
mr Montana
OR Oregon
ur Utah

946870 | 1120 WASHINGTON D.C. FULLFIELD SaMPLES DC = Federal
o Colorado
" Florida
ca Georgia
MD Maryland Qualified
y New York Qualified
sc South Carolina Qualified

4721|1120 WASHINGTON DC TEST COMPANY SAMPLES DC FeD Federal Qualified
co Colorado Qualified |
FL Florida Qualified
GA Georgia Qualified
o Maryland Qualified

ol ] ,

s [

Figure 8:22
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CHAPTER 9: VALIDATIONS

The IRS has defined a rigid structure that must be used to create e-file tax returns. This structure is necessary
and critical to ensure e-file returns can be transmitted to and viewed by IRS systems. E-file returns not meeting
these requirements will be rejected by the IRS.

To ensure returns meet its strict formatting requirements, the IRS performs two levels of validations on all
received returns: business rule validation and schema validation.

BUSINESS RULE VALIDATION

The MeF system verifies the return data against a series of business rules. Most business rules test for such
things as missing information, mismatched information, or incorrect data. Two examples are:

o IfForm 1120, line 8 has a non-zero value, then Schedule D (Form 1120) must be attached.

o IfForm 1120, Schedule L is present, Form 1120, Item D Total Assets must equal Form 1120, Schedule L,
line 15d.

Abusiness rule that fails will result in a reject diagnostic and will prevent the return from being e-filed.

Business rule validations consist of two types of reject diagnostics. One type of reject diagnostic compares
information within the return to the business rules. These diagnostics can be cleared by correcting the tax
return information and computing the return.

The second type of diagnostic is generated by the Business Rules Management System (BRMS). The BRMS
compares the e-file XML file to the business rules. These diagnostics are cleared by correcting the tax return
information and re-creating the e-file or re-generating the validation file. Diagnostics generated through BRMS
are identified by an asterisk appearing in front of the diagnostic

Business rules also include database validation checks to ensure information contained in the e-file agrees with
information contained in the IRS databases. For example, if the taxpayer’s EIN and Name Control (first four
characters of the taxpayer name) do not match data in the IRS e-file database, the return will be rejected. This
type of business rule violation cannot be detected until the return is submitted to the IRS.

SCHEMA VALIDATION

Schemas provide the basic definition for elements — what is required, field length, data type, allowable values,
etc. Data integrity depends on each data element complying with the data format specifications. The MeF
system verifies this by validating each return against the schemas. If a data format error is encountered, the
return is rejected.
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Correcting Validation Errors with GoTo Functionality

When the e-file is created, we automatically validate the XML file against the IRS schemas. If there are XML
validation errors, the number of errors is reported on the Create E-file screen, and each error is displayed in
the View > Diagnostics menu. An e-file cannot be submitted if validation errors exist.

CORRECTING VALIDATION ERRORS WITH GOTO
FUNCTIONALITY

Creating the e-file also identifies and reports any validation errors that exist, but the validation error message
can be difficult to understand, and finding where to correct the error might not be clear. To aid in correcting
validation errors, a Validation File can be created that includes GoTo functionality.

Follow the steps below to create a Validation File with the GoTo functionality:

1. Inthe Organizer, select Federal E-file > Error Checking, and then select the Generate Validation
File button.

E-FILE ERROR CHECKING

Generate Validation File

Note: This feature generates drill down/go-to functionality from view |diagnostics| e-file validation errors to the location of the error in the organizer.

E-file status. ...
Dateftime XML validation file created.... ...
Number of XML validation errors_._.._._._...._...__._..._.

Filemame. ...

Figure 9:1

2. Creating the XML file with the GoTo functionality for states is performed separately in the State E-file >
Validation spreadsheet.

3. After the validation file is created, access View > Diagnostics > E-file Validation Errors.

4. Selecting a validation error should take you to the source of the error. The source of the error can be an
Organizer or a Tax Form field. If the error is contained in a Tax Form field, you should hyperlink to the
applicable Organizer field to update.

5. Repeat this process until all validation errors are eliminated.
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Correcting Validation Errors with GoTo Functionality

6. After all validation errors are eliminated, use Create E-file to create the final XML file that can be
transmitted.

7. GoTo functionality is not available for XML files created using the Create E-file button. However, if an

XML file is created using the Create E-file steps shown above then the GoTo functionality should be
reestablished.

| D/‘ The GoTo capability does not function for some XML validation errors.
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CHAPTER 10: REVIEWING THE E-FILE

RETURN

Business returns and extensions are transmitted to the IRS as XML files. The XML file can be downloaded from
the RS Browser for your review and record keeping, and can also be reviewed with the E-file Viewer.

DOWNLOADING THE XML FILE FOR REVIEW

1. From the RS Browser, select Returns Processing > E-file > Download > Select Returns.

Home Returns Returns Processing

Admin  Reports  Support

E-file Download

AE-file
Select Returns
Batch Status Account: | 2MKN Sort Lis
Status Report (@) Nan
4Download Year: O Lot
Select Returns Type: And Mal
Batch Status Characty
: < O 1040 O 5500
» Print O1oa1 O emo
| 4 _E’ansamﬂrogﬁf_,sing - A A04 P A
ine  se POF Attachinents: u
Figure 10:1

2. Use the drop-down lists to select an Account and the Year for the e-files you want to download. Select
one of the options for the return Type. To further refine your search, employ the Sort List by and
Assigned To options. After selecting the Jurisdiction from the drop-down list, select Continue.
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Downloading the XML File For Review

3. Forthe account and criteria selected, a list of available returns is shown, Select the check box to select e-
files to download, and then select Continue.

Home Returns Returns Processing Admin  Reports  Support e-Form RS

=B 1120 Returns Found in Account 2MKN:
Select Retums
Batch Status Select Return Taxpayer Name Client Code ELF Status Jurisdiction

3537IT Galaxy Electronics, Inc Qualified FED

Status Report
4Download
g:{:ﬁlsﬁg_;ms 1 record returned.
b Print
¥ Preseason Processing
b Estimates & Extensions
b Import/Export
b Transfer
Move From Thomson Reuters Archive

Continue Select All Deselect All Cancel Next 10

Figure 10:2

| D/‘ Even though more than one file can be listed, only one return can be selected.

4. AFederal e-File Download page is displayed for you to confirm your selection. Select Close.

1120 Federal e-File Download

[Firm Jaccount [vear [Tax Type |
[ ez21 I 120 ]
[Locator |lstatus |
llso1215 |[Export Queued |

Export Batch job: 74822
1 returns queued
0 returns rejected

Figure 10:3
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Downloading the XML File For Review

Select Batch Status on the left menu. Use the drop-down list to select a Year and Return Type on the
Batch Status screen. If desired, enter the Date Batch Submitted dates (From (MM/DD/YYYY) and To
(MM/DD/YYYY). Select Continue.

Home Returns Returns Processing Admin  Reports Support e-Form RS
4E-file Batch Status
Select Retums
Batch Status User:
Status Report
4Download Date Batch Submitted
Select Returns
From (MM/DD/YYYY):
¥ Print To (MM/DDIYYYY):
» Preseason Processing
) Estimates & Extensions Tax Year
¥ Import/Export Return Type
» Transfer
Move From Thomson Reuters Archive
| Continue | | Cancel |

Figure 10:4

Select the Batch ID hyperlink for the return you want to download.

E-file Download Batches Found:

Date/Time |Tax Year| Tax Type| Itemsl Batch ID
12/1/0 | 9:30:45 AM| [1120 [1 |74822

1 batch found.

Figure 10:5
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Chapter 10: Reviewing the E-file Return
Downloading the XML File For Review

7. The e-File Download Batch Details dialog box is displayed. Select Download All. However, if the

10.

11.

1120 Federal e-File Download Batch Details

Export Status for Batch ID 74822:

NOTE: A Password input field indicates a password is reguired. These returns are not included in the Download All button. To download a
password protected return when the 'Print File Ready’ status is displayed, please enter the password and click on the return’s hyperlink.

Return Password Entity Name Export Status  WIP Status Download Status
501215 |essss TOH-Downlt, Inc.  File Export Complete WIPO

1 reco, yurned.

Refresh Cancel Download All

Figure 10:6

return has a password, select the return hyperlink after entering the password in the field.

A pop-up dialog box is displayed at the bottom of the screen. Select Open to save the XML as before, or
select Save, Save As, or Save and Open from the drop-down list options to save the ZIP file.

Do you want to open or save rad1BA11.zip from pd-gosystemrs.fasttax.com? J.

Figure 10:7

Download the file to the location selected on the Browse for Folder dialog box. Select OK.

The e-File Download Batch Details dialog box displays a dialog box that indicates Download complete,

and displays File Export Complete in the Export Status column.

1120 Federal e-File Download Batch Details

Export Status for Batch ID 74822:

NOTE: A Password input field indicates a password is required. These returns are not included in the Download All butten. To download a
password protected return when the 'Print File Ready’ status is displayed, please enter the password and click on the return’s hyperlink.

Return Password Entity Name Export Status ~ WIP Status Download Status

901215 TOH-DownIt, Inc. | File Export Complete WIPD

1 record returned.

Refresh Cancel Download All

Figure 10:8

At the bottom of the screen on the popup dialog box, select Open. View the ZIP file by selecting the XML

file inside the ZIP application, or saving the file and using a text editor.

THOMSON REUTERS
1120 E-FILE GUIDE




Chapter 10: Reviewing the E-file Return

Reviewing with Internet Explorer or a Text Editor

REVIEWING WITH INTERNET EXPLORER OR A TEXT
EDITOR

You can view the XML file using the Internet Explorer browser or a text editor, such as Notepad.

1. When viewing the XML file, the return/extension data can be identified by the surrounding schema
element names (enclosed in angled brackets, such as <TOTALDEDUCTIONS>) and the number
(267199) highlighted below.

*

«</ReturnHeader >
- <ReturnData documentCount="9">
- «IR511205 documentId="[RS11205"=>

<EffectiveDateOfElecticn>1987-02-05 </EffectiveDateOfElection=

<BusinessActivityCode >523900 </BusinessActvityCode>

<SchM3Attached referenceDocumentIld="IRS11208SchM3" X =/SchM3Attached>

<Datelncorporated>1987-02-05</Datelncorporated >

<MNumberOfShareHolders referenceDocumentId="IRS1120SSchK1
IRS112055chK1N1">2</NumberOfShareHolders >

<Depreciation referenceDocumentId="IRS4562"=267199 </Depreciation=>

<TotalDeductions>267199 </TotalDeductions>

<OrdinaryIncomelossFromTrade >- 267199 </OrdinaryIncomelossFromrTrade >

<Balancelue =0</BalancebDue=

<IRS112055chedulea />

- <IRS112055cheduleB>

«MethodOfAccountngAccrual =X </MethodOfAccountingAccrual »
<BusinessActivity >ASSET MANAGEMENT </BusinessActivity >
<ProductOrService>ASSET MANAGEMENT </ProductOrService >
<Dwn50PercentOrMoreVotingStock>false </0wn50PercentOrMoreVotingStock:=
<FiledOrRequiredToFileUnder6111=false</FiledOrRequiredToFileUnder6111 >
<RequiredToCompleteSchLAndSchM1 sfalse</RequiredToCompleteSchLAndSchM1=

«/IRS112055cheduleB >

i sIRS1IAASScheduleks F e \JM " /- r

36..010</0thervestmentsBOy = N
«BldgOtherDepreciableAssetsBOY »>5959633 </BldgOtherDepreciableAssetsBOY =
<AccumulatedDepreciationBOY >4291976 </AccumulatedDepreciationBOY =

MotDaonraciahlagfccgtcBny 1RARTRS T ~NothanracighlagAccgtcBly

?crzxrozs%vu‘xm |_} -8

Figure 10:9
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2. By reviewing the actual XML file in an editor, you can confirm the accuracy of the return or extension e-file
thatis sent to the IRS.

File Edit Format ‘iew Help

<Returnbata documentCount="95">
<IR511205 documentId="TIRS511205">

<EffectivebatedfElection=Llyy/-02-0s< /Effect ‘ivEDateOfE‘\ectiDrw

<BusinessactivityCodes523900</Businassact ivityCod

<schm3attached FE‘FEFEHCEDDCumEI‘\tId—”IRSllZ')SSChM}")X</SChM3AttaChEd>

<Date1ncorﬁorated>1987 02-05</Datelncorporateds

<Numberofsharetolders referencebocumentId="TR5112055chKl

IRS112055chk1NL">2</Mumberofsharedolderss

<bepreciation referancebocumentId="IR54562 '»26719%9</Depraeciation:

<Totalbeductions»>267199</Totalpeductions >

<ordinaryIncomeLossFromTrade>-267199</0rdinaryIncomeLossFromTradas

<Balancebue>0</Balancepuas

<IRs112055chedulens/>

<IRs1120s5cheduless
“mathodofaccount ingaccrual =z Mathodofaccountingaccruals
<BusinessAct Tuity»ASSET MAMAGEMENT</BusinassActivitys
<ProductorServicesASSET MAMAGEMENT</Productorservices

[<own 50Per centormorevotingstock>false< Owns0Percentormorevatingstocks
<Filedorreguiredtorileunderélll>false</FiledorrequiredTorileunder 6111

<ReguiredTocompleteschiandschmls>false</RequiredrocompleteschLandschmls
</IRS112055chedul B>
<IRs1120s5cheduleks
<ordinaryIincomeloss>-267199</0rdinaryIncomelLoss >

<ForeignCountryor USPossVARIOUS>VARIOUS </ For e gniountryorUsPos svARIOUS:
<Post1986Depraciationad]»>6850</Pos-19860eprecationad]>
<IncomeLossReconciliation»-267199</IncomeLossreconciliations
</IRs11205schedul exs
<IRS112055chedulel >
<Casheoy>2703215</CashBovs

<TradenotesacctReceivableBov>1071155</TradeNotesacctreceivablesoy s>

[<MetTradeNotesAacctRoVE]BOY>1071155< /MNetTradenotesAccTROvh T BOY >
<0thercurrentassetsgov
referencebocumentId="ITemCasset ">0< /OTherCur rentASSeTsBoYY
<LoansToShareholdarsBov»>22568300<,/LoansToshareholderseoy s
<otherInvastmentsBoy
referencebocumentId="ItemoImnvestsch>-3815610<,/2ther InvestmentsEoy >

<BldyotherbepreciahleassetsBoy>5359633</B1dgotherpepreciableasset sEOY >
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Reviewing with the E-file Viewer

REVIEWING WITH THE E-FILE VIEWER

The E-file Viewer presents the contents of your XML files in Acrobat (PDF) format and organized according to
the IRS and state provided schemas. The XML file contents are displayed with identifying information pulled
directly from the schemas.

o The descriptions in the PDF file rely on working links to provide supporting schema details. Blue
underlined hyperlinks make navigation to supporting documents, such as other forms or schedules,
trouble-free.

« Each page of the PDF file includes the taxpayer name, federal ID number (FEIN), page number, and the
date the XML file was created.

« PDF bookmarks provide a way to quickly jump to specific forms or supporting details. Where multiple
forms or schedules are included, the number of forms and schedules are indicated parenthetically, and
the bookmark can be expanded to list each form and schedule.

« Shortcut keys are available as an aid to navigation. For example, type Alt + Left Arrow to return to the
previous view.

« The PDF file is searchable using the Find feature. For example, an element name thatis found in a
validation error can be entered in the field and searched for quickly. Knowing the context of the data can
help resolve validation issues.

« The E-file Viewer can be accessed faster, especially when loading large XML files. You no longer need to
exit the return to view either the XML or PDF file.

« The PDF file can be saved by the E-file Viewer on your local machine.

Accessing the E-file Viewer

A PDF file was automatically created when you selected the Create button to create a federal or state e-file.

1. To view the PDF file, you do not need to exit the return. Access the RS Browser Returns screen and enter
your search criteria, including the Account, Return number, Tax Type, Taxpayer Name, and Year.
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Reviewing with the E-file Viewer

2. Ifuncertain about the account number, select All Accounts, enter either a Return Number or a
Taxpayer Name, and then select Search. If a return is found, select the Taxpayer Name.

Home FReturns Returns Processing Admin  Reports  Support e-Form RS
Returns Record Count : 5
© Create More v 2 Reset o]
Account ¥ | Return ¥ TaxType ¥ |T{ All Accounts ¥ pleted Date
Len || stetswi | o v | fains..
IMKN 29031X 1065 d Please refine your search of all accounts by either: A
P e — - q @® Return Number
2MKN 69101y 1065 1
2MKN 9858IU 1065 H
or
2MKN 9963IS 1065 A
O Taxpayer Name
Tax Type will be filtered by the type already chosen on the Returns grid.
* One field is required
v
L < X >
<[ 1 1> M |25 items per page P —

Figure 10:11

3. Selectthe check box to select a return, and the E-file Viewer button is displayed in the menu bar. Select
the E-file Viewer button.

Home Returns Retumns Processing Admin  Reports  Support

Returns

© Create %) Open O Info ® E-file Viewer X SaveAs

Acglint ¥ | Return ¥ | Tax Type ¥ | Taxpayer Nam>.
4 v 901218 x 1120 v contains..
58321 901215 1120 TOH-Downlt, Inc.

Figure 10:12
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Reviewing with the E-file Viewer

4. The E-file Viewer opens with two main panes. The right pane contains additional information on using the
E-file Viewer, and disappears when the PDF or XML file is displayed.

[Farsea E-file Review Help
=@ f‘edela\ Retum A
HE IThe E-file Review allows you to view, print and save the PDF format of the electronic file data you created. The system converts your XML file info PDF
> &3 Arszhmerts in grid format to make it easier for you to review the retum,.
Sravan

6 Gross rents GrossRents.

7 Cromsroyaies Sor

0 Captal gt e 2500 | Comcaminons

s et g o oss rom Form 757 e Form 4767 31600 | Rercarions

B Otvr ncome e

T T neome 700 Tominee

« Column 1 reflects the actual form line number.
« Column 2 lists each line description.

« Column 3 displays the balance for the line item.

« Column 4 includes the XML tag for each line item.

You can also download the actual XML for archiving, reviewing in Internet explorer, or other purposes:
Viewing, Printing and Saving PDF
|After successfully generating e-file XML, click on the PDF node in the E-file Review navigation tree to access the file. Large PDF file may take several

Iminutes to be downloaded. Please do not click on the PDF node repeatedly as it restarts the process every time it is invoked. Once completed, it should
display your file using the Adobe Reader.

3::jr=dm| .:’ 4 $[1 /2 ®®[0ax% - = 4 [[Find -

=8 E;un
Ful ML i Bookmarks

543 Staes &

=@ Alabama Regular - xal -
[ FullmL h =
—r— & Colorado Regular-xc0 = %] c0013260_XCO
Print || Close || Help - A an oo mainnon o =

Figure 10:13

5. The left pane contains the navigation tree for viewing the XML or PDF file. The XML file is displayed in the
right pane.

& /O Federal
&8 Federal Retum <?xml versiol
. - <Return xml

"1.0" encoding="UTF-8" 7> A
+/ /www.irs.gov/efile” xmins:efile="http:/ /www.irs.gov/efile"
"http://www.irs.gov/efile ../Return1120.xsd" xmins:xsi="http: / /www.w3.0rg/2001/XMLSchema-instance"
returnVersion="20 [ v2.0">
- <ReturnHeader binaryAttachmentCnt="0">
<ReturnTs>20.  -09-22T14:25:14-06:00</ReturnTs>
<les o>
<TaxPeriodEndDt>20 -12-31</TaxPeriodEndDt>
- <PreparerFirmGrp>
<PreparerFirmEIN>454572544</PreparerFirmEIN>
- <PreparerFirmName>
<BusinessNameLine1Txt>Thompson and Rogers CPAs</BusinessNameLine1Txt>
</PreparerFirmName>
- <PreparerUSAddress>
<AddressLine1Txt>4536 Park Lane</AddressLine1Txt>
<CityNm >Plano</CityNm>
< bbreviationCd>TX< ionCd>
<ZIPCd>79095</ZI1PCd>
</PreparerUSAddress>
</PreparerFirmGrp>
<Softwareld>15000213</Softwareld>
<SoftwareVersionNum>16-1F </SoftwareVersionNum>
<M jsedInd>false</MultSoftwareP jsednd>
- <OriginatorGrp>
<EFIN>712345</EFIN>
<OriginatorTypeCd>ERO</OriginatorTypeCd>
- <PractitionerPINGrp>
<EFIN>712345</EFIN>
<PIN>45457</PIN>
</PractitionerPINGrp>
</OriginatorGrp>
<PINEnteredByCd>ERO</PINEnteredByCd>
<SignatureOptionCd>PIN Number</SignatureOptionCd>
<ReturnTypeCd>1120</ReturnTypeCd>
<TaxPeriodBeginDt>20/ -01-01</TaxPeriodBeginDt>
- <Filer>

Print | Close = Help <EIN>751234567 </EIN> Vi

(] Full XML

Figure 10:14
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Reviewing with the E-file Viewer

6. Selectthe PDF folder to access the PDF file. A pop-up is displayed at the bottom of the screen. Select
Open. The PDF is displayed as a grid with columns for line number (if applicable) in a separate window. A
description of the schema element, data from the XML file, and schema element name. The Acrobat
toolbar is displayed at the top of the pane.

e Eat Ven Vndon reb
Home Tools Document ® B8 xR B B @ @ [1» © 2 ® B
751234567
IRS1120 [documentld:IRS1120](link:SCHB]
Special condition description SpecialConditionDesc
Ala Indicates this is a consolidated return ConsolidatedReturnind
Indicates this is a parent return ParentReturnind
Indicates this is a subsidiary return SubsidiaryRetumind
A1b Indicates this is a life/nonlife consolidated return LifeNonlifeConsolidatedRetind
A2 Indicates this is a return for a personal holding company PersonalHoldingCompanylnd
A3 Indicates this is a return for a personal service corporation PersonalServiceCorporationind
A4 Indicates Schedule M-3 is attached [link: SCHM3] X | ScheduleM3Attachedind
Cc Date incorporated 1999-10-10 | IncorporationDt
D Total assets. 126613 | TotalAssetsAmt
b E(1) Indicates this is an initial return InitialReturnind
E@2) Indicates this is a final return FinalReturnind
E(3) Indicates this is return has a name change return NameChangelnd
E(4) Indicates this retum has an address change AddressChangelnd
E(5) Indicates this retum is an amended return ‘AmendedRetunind
E(6) Indicates this retum is a superseded return SupersededReturnind
1a Gross receipts or sales 6832742 | GrossReceiptsOrSalesAmt
1b Gross receipts or sales not reported on line 1a 8098 | RetumsAndAllowancesAmt
1c Subtract line 1b from line 1a 6824644 | NetGrossReceiptsOrSalesAmt
2 Cost of goods sold CostOfGoodsSoldAmt
3 Gross profit 6824644 | GrossProfitAmt
4 Dividends TotalDividendsReceivedAmt
5 Interest income TaxablelnterestAmt
6 Gross rents GrossRentsAmt
7 Gross royalties GrossRoyaltiesAmt
8 Capital gain net income [link:IRS1120SchD] 27998 | CapitalGainNetincomeAmt

Figure 10:15

7. The toolbar allows you to send the PDF file in an e-mail (letter icon), accessing a page directly by typing a
number in the page field on the left (or using the up and down arrows), or Find content by selecting the
bookmarks icon.

Fie Edt Vew Window Hel
Home Tools Document ® B8 = B B & Q i 2 | © &2 ® B
Bookmarks X
., 751234567
0] = o
IRS1120 [documentd:IRS1120]ink:SCHB]
=[] C3537IT5 Federal Return
Special condition description ‘SpecialCondiionDesc
[ 1rs1120 Ala Indicates this is a consolidated retum ConsoidatedRetumind
[1 IRS1120ScheduleB. Indicates this is a parent return ParentRetumind
[] RS11205cheduleD Indicates this is a subsidiary retur SubsdarRetming
Alb Indicates this is a life/nonlife consolidated return LifeNoniifeConsolidatedRetind
[1 I1RS11205cheduleM3
A2 Indicates this is a return for a personal holding company PersonalHoldingCompanyind
[ 1Rs11205cheduleN A3 Indicates this is a retur for a personal service corporation PersonalsenviceComporatonind
[ IRs2220 A4 Indicates Schedule M-3 is attached [link:SCHM3] X | ScheculeM3Attacheding
[ 1Rs4626 c Date incorporated 1999-10-10 | incorporationdt
D Total assets. 126613 | TotalAssetsamt
[1 Rs5471
E(1) Indicates this is an initial return InitialReturnind
[ 1Rs5471Schedule) @) Indicates this i a final return FinalRetumind
[] 1Rs8949 E(3) Indicates this is return has a name change return NameChangeind
i < E(4) Indicates this return has an address change AddressChangeind
dule E(5) Indicates this return is an amended return ‘AmendedRetumind
[1 1RsPayment E6) Indicates this return is a superseded return SupersededRetumind
1a Gross receipts or sales. 6832742 | GrossReceiptsOrSalesAmt
1b ts or sales not reported on line 13 8098

Figure 10:16
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Using the E-file Viewer

Chapter 10: Reviewing the E-file Return 89

Reviewing with the E-file Viewer

The XML header information, such as taxpayer and paid preparer information, is not displayed in
the PDF. However, this information can be verified by reviewing the full XML file. Select the file
under the PDF folder. For advanced use of the Adobe® Acrobat Reader® DC, see

https://helpx.adobe.com/reader.html.

The PDF grid is displayed in a separate window when using the E-file Viewer.

Galaxy Electronics Inc 751234567
IR51120 RS1120]: 120
Special condition description ‘SpedaConditicnDescription
Ala Indicates this is a consclidated retum IsConsollaatedRetum
Indicates this is a parent retum IsParenifetm
Indicates this is a subsidiary return IsSubsidanRetum

Alb Indicates this is a life/noniife consolidated retum LifeNoniifeConsolldaiedRetum
A2 Indicates this is a retum for a personal holding company PersonalHoidingCompary

A3 Indicates this is a retum for a personal service corporation PersonalSenvicaCorporation

Al Indicates Schedule M-3 is attached ScheduleM3Atached

c Date incorporated Dateincomorated

o Total assets TotalAssets

E(1) Indicates this is an initial return InitaiFstum

E(2) Indicates this 5 a final retum FinaiRetum

E(3) Indicates this is return has a name change return NameChange

Ei4) Indicates this retum has an address change AddressChange

E(5) Indicates this return is an amended retum AmengeRetum

E(8) Indicates this return is a superseded retum ‘SupersededRatum

1a Merchant card and third party payments MerchantCaraThirg anyPsyments
1b Gross receipts or sales not reported on line 12 GmesRecsintsSalesNatRepared
1c Total. Add lines 1a and 1b. Totalline1aAnd it

1d Less returns and allowances RemumsAndAliowances

Figure 10:17

PDF Grid View

As shown in the example below, each page of the PDF file includes:

THOMSON REUTERS
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o« An EIN or SSN

« Atimestamp when the PDF was created

« A page number

All schema elements are displayed whether or not they are populated.

more of the corporation’s voting stock

1c Name of other accounting method used [methodOfAccountingOtherDesc :Other Method] X | MethodOf#coountingOtherind

2a Business activity code ne. 856656 | PrincipalBusinessActiviyCd

2a Inactive business activity code InactivePrincipalBusActyCd

20 Business activity Sales | PrincipalBusinessActivityDess

2 Product or service Electronics | PrincipslProductDese

3 Igr}g\:gles the corporation is a subsidiary in an affiliated group or a parent-subsidiary controlled false | ControlledGroupMemberind

Name of the parent corporaticn

3 Business name line 1 BusinessNameLine1Txt

3 Business name line 2 BusinessNameLine2Txt

3 Name control of the parent corporation PmtCorporationNameContoi Tt

3 EIN of the parent corperation ParentCorporationEIN

3 Missing EIN reason MizsingEINReasonCd

4a Indicates any partnership, corporation, or trust or tax exempt organization own directly 20% or false | PrishpCorpTrOwnPciVingStkind
more or indirectly 50% or more of the corporation's voting stock

4b Any individual, estate or trust own directly 20% or more or directly or indirectly 50% or more of false | IndvEs{TrOwWnFetVingStiind
the corporation's voting stock?

5a Indicates any partnership, corporation, or trust own directly 20% or more or indirectly 50% or false | CorporationOwnedPcfyingStkind

Corporation cowning voting stock table

Name of corporation

Sa(i)

[ Business name fine 1

‘ BusinessNameLineTTx

Sa(i)

| Business name line 2

‘ BusinessNameLineZTxt
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Reviewing with the E-file Viewer

Abar is displayed at the beginning of each form schema. This bar includes the schema name, the document ID
associated with the schema, any informational text that might be applicable and links (blue underlined text) to
any supplemental schemas called by the form but not called by a specific line number.

IRS1120ScheduleD [documentld:IRS1120SchD][link:IRS8949]

TotalSTCGL1059BBssRptNoAdjGrp

é a{g:and Total proceeds (sales price) from Form 1099-B TotalProcesdsSalesPricsAmt
a3l

1ale)and Cost (or other basis) TotalCostOrOtherBasizAmt
Bale

Ta(h) and Total gain or loss amt TotalGainOr_ossAmt

Balh

Short-term totals from Form 854% with box A checked in Part I

1b{dg, 2(d), | Total proceeds (sales price} from Form 8949
d), Bb(d)

;
SLdg an
10(d)”

TotalProcesdsSalesPriceAmt

" b{e!, 2{[?)‘ Total cost or other basis

TotalCostOrOtherBasisAmt

Figure 10:20

When the schemas have multiple choice elements, where only one element can be chosen, the descriptions of
each choice element are indented. For example, for Method of Accounting, cash, accrual, and other might

apply, but only one can be selected.

IRS1120ScheduleM3 [documentld:SCHM3]

Business name

Business name line 1

Galaxy Electronics Inc | BusinesshameLine1Txt

Business name line 2

BusinessMameLine2Txt

EIN

751234567 | EIN

Missing EIN reason

MissingEINReasonCd

Indicates this is a non-consolidated retumn

X | MenCensolidatedRetumnind

Indicates this is a consolidated return

ConsolidatedRetumind

Indicates this is a mixed 1120/L/PC group

Mixed1120LPCGroupind

Indicates dormant subsidiaries schedule attached DormantSubsidiariesSchattind
1a Did the;:}orporalion file SEC Form 10-K for its income statement period ending with or within this false | CorporationFiledSECForm10KInd
tax year?

Figure 10:21
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Iltems are displayed in consecutive order with a header indicating the beginning of each occurrence
example displays two separate items that are included in Other Current Assets.

. This

ItemizedOtherCurrenthAssetsSch [documentid:itemCAsset1120]

ItemizedOtherCurrenthsset

Corporaticn Name

Business name line 1

Galaxy Electronics Inc

BusinessNameLine1

Business name line 2

BusinessNameLine2

Corporation EIN

751234567

CorporationEIN

Missing EIN reazon

MissingEINReason

Other Current Asset line item

Other Current Asset Description Prepaid Deposits | Description

Beginning Amount 6000 | BeginningAmount

Ending Amount 75400 | EndingAmeount
Other Current Asset line item

Other Current Asset Description Customer 1QUs | Description

Beginning Amount 1200 | BegmnningAmount

Ending Amount 45000 | EndingAmount

Hyperlinks (blue underlined text) are available to jump to supporting details. For example, if a detail exists for

Other Income on line 10, the description will have a hyperlink (see red arrow below).

4 Dividends Dividends

5 Interest income Interestincome

6 Gross rents GrossRents

7 Gross royalties GrossRoyalties

8 Capital gain net income CapitalGainMetincome
9 Net gain or loss from Form 4797 (attach Form 4797) NetGainLoss

10 Other income [link:ltemOthinc1120] 773098 | otherincome

11 Total income ~ 90772008 | Totallncome

Select the link to view the supporting detail. This example displays the first item included in Other Income.

ItemizedOtherIncomeSchedule [documentid:itemOthingd 120]

ItemizedIncome

Corporation Name

Business name line 1

Galaxy Electronics Inc

BusinessNameLine1

Business name line 2

BusinessNameLine2

Corporation EIN 751234567 | CorporationEIN

Missing EIN reascn MissingEINReason
Income type Consulting Fees | IncomeType
Amount 154650 | Amount




Bookmark View

Chapter 10: Reviewing the E-file Return

Reviewing with the E-file Viewer

The Bookmark view lists the form and schedule schemas included in the PDF file. Select the second icon (red

arrow) to open this view.

Home Tools Document
Bookmarks
u (=l @ Eb 1-;-0

- 55371T5_Federal Return

[] IRs1120

[] IRS11205cheduleB
[] 1RS1120ScheduleD
[] 1RS11205cheduleM3
[] IRS1120ScheduleN

[] mrs2220

® B

Figure 10:25

Select each form or schedule schema to take you to that specific section in the PDF file.

N =B Wl

&[] €3537IT5 Federal Return
[] IRs1120
[ IRS11205cheduleB
[ IRS1120ScheduleD
[1 IRS1120ScheduleM3
[ IRS1120Schedulel
[l Rs2220
[l IRs4626
[ IRs5471 |
2 pprerra—
] IRs8949

|:| ItemizedOtherincomeSche
dule

|:| IRSPayment

Home Tools Document (ﬁb E = Eha = i
Bookmarks X IRS5471 [documentld:IRS547 1][link:IRS547 1SchJ]

Tax year beginning

Tax year ending

Change in taxable year - No section 898¢(1)(B)

Electien - Change in year 898¢(1)(B)

Section 898c(1)(B) election

Section 338(g) Election

Person filing this return

BusinessName

‘ Business name line 1

‘ Business name line 2

UsShddress

Address line 1

Address line 2

City

State

ZIP code

ForeignAddress

Address line 1

Address line 2

City

Pravince or state

Country

Figure 10:26
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Reviewing with the E-file Viewer

As shown below, a form, such as Form 5471, can have multiple instances. The total number of forms is shown
inside a parenthesis (5). Also, a plus sign is displayed next to the file name when more than one instance of the
form exists in the PDF file. Select the plus sign to expand the list and see that each file has a unique identify
number (such as IRS5471N1, IRS547N2, IRS547N3, and so forth). The first instance of the form is the item
shown with the parenthesis, while the second instance has N7 at the end of the description. Select the
bookmark to go to the instance of that form.

Bookmarks »
-
(WIS 7 2
=[] C4609IT5 Federal Return
[1 1Rs1120
[] 1RS1120ScheduleB
[l IRS1120ScheduleM3
[] 1RS1120ScheduleN

[l IRS4626
=[] IRS5471 (5)

[] IRS5471N1
[] IRS5471N2
[] IRS5471N3

[] IRS5471N4

D IR554715¢chedule) (5)

Figure 10:27
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CHAPTER 11: TRANSMISSIONS AND
ACKNOWLEDGMENTS

TRANSMISSIONS

An electronic postmark is created bearing the date and time (Central time zone) that the e-file is received at the
host computers. If timeliness of filing is in question, the IRS uses the electronic postmark that is adjusted to the
time of the taxpayer. For example, if the taxpayer is located in the Eastern time zone, one hour would be added
to the electronic postmark to determine the filing time. Conversely, if the taxpayer is located in the Pacific time
zone, two hours would be subtracted from the electronic postmark.

If the electronic postmark is on or before the prescribed deadline for filing, but the return or extension is
received by the IRS after the prescribed deadline for filing, it is treated as filed on the electronic postmark’s date
if received within two days of the electronic postmark. If the electronic postmark is after the prescribed deadline
for filing, the IRS receipt date is the actual filing date.

THOMSON REUTERS
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Acknowledgments

ACKNOWLEDGMENTS

The IRS electronically acknowledges the receipt of all returns and extensions as either Accepted or Rejected
for specific reasons. Returns and extensions which pass all IRS validations are considered filed as soon as they
are accepted. Returns and extension that do not pass validation are rejected, and are considered not accepted.

Example of Acknowledgment Information

ELECTRONIC RETURN ACKNOWLEDGEMENT

O Suppress print of acknowledgement

Return identification number...._...._... .

Return type. ..o

Filing type description......................ceceeeeeeeee... Federal Return
Taxperiod begindate ... ... |myoDsyyyy
Taxperiodenddate. ... ... |moDsyEEy
Containalerts..................

IRS receive date................. [MM/DD/EEYY
Walidation completed. ...

Electronic postmark............

Return status...........

IRS processdate. ... MM/OD/YEYY
Taxable income.............

Total tax. ..o

Payment indicator................o

Embedded CRC32. ...,
Computed CRC32.

Figure 11:1
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Transmission Perfection Period For Rejected Returns

To generate an Electronic Return Acknowledgment:
1. Goto Federal E-file > Status.
2. Scroll down the screen to view the Electronic Return Acknowledgment section.

3. Selectthe IRS Acknowledgment link to view the taxable income acknowledgment shown below.

RETURN ACKNOWLEDGMENT

Taxable income per IRS acknowledgment................

IRS Acknowledgment

Figure 11:2

TRANSMISSION PERFECTION PERIOD FOR REJECTED
RETURNS

When a transmitted e-file return is rejected, there is a 10-day Transmission Perfection Period to prepare that
return for e-file retransmission. For Form 7004 extensions, the perfection period is only five (5) days.
Perfection of the return for e-file retransmission generally means that the originally signed return might have
errors in the format of the XML or errors that cause the return to fail the IRS e-file business rules. When a
previously rejected electronic return is Accepted by the IRS within the 10-day Transmission Perfection Period, it
is deemed to have been received on the date of the first reject that occurred within that 10-day period.

In other words, the 10 days is actually a look back period, and is determined once the return is accepted. The
IRS looks back 10 days from the date the return is Accepted to determine if there have been any rejects for the
same EIN and Year. If there have been one or more rejects within that 10 day look back period, the IRS uses
the received date on the earliest reject as the received date for the Accepted return. Refer to IRS Publication
4163 - Modernized e-File (MeF) Information for Authorized IR S e-File Providers for Business Returns for more
information regarding rejected returns and extensions.

The Transmission Perfection Period is NOT an extension of time to file; it is a period of time that is granted
to correct errors in the E-file. The Transmission Perfection Period applies to business returns filed on MeF,
without regard to the date filed, due date, or extended due date. The yearly cut-over period does not
extend the 10-day Transmission Perfection Period. Moreover, the perfection period is never extended for
weekends, holidays, or the end of the year cutoff.

THOMSON REUTERS
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Transmission Perfection Period For Rejected Returns

Rejected E-filed Returns

Taxpayers who cannot get their return accepted or who decide to file a paper return instead, must also ensure
that their paper return is filed timely. To be considered timely filed, this paper return must be postmarked by the
later of the due date of the return (including extensions), or ten (10) calendar days after the date the IRS last
gives notification that the return was rejected.

Follow the steps below to ensure that the paper return is identified as a rejected electronic return, and the
taxpayer is given credit for the date of the first reject within the 10 day transmission perfection period:

1.

The taxpayer must call the IRS (at 1-866-255-0654) to advise that they have not been able to have their
return accepted. The e-Help Desk then provides an e-case number to the taxpayer.

The taxpayer should prepare the paper return and include the following:
« An explanation of why the paper return is being filed after the due date.
« Acopy of the reject notification.
« Abrief history of actions taken to correct the electronic return.

Write in red at the top of the first page of the paper return REJECTED ELECTRONIC RETURN -
(DATE). The date indicated should be the date of the first reject within the 10-day transmission perfection
time frame.

The taxpayer must sign the paper return. The PIN that was used on the rejected e-file return cannot be
used as the signature on the paper return.

Help Desk (1-866-255-0654) for assistance in correcting rejects before filing a paper return.

‘ D/‘ Corporations, partnerships, and tax-exempt organizations required to e-file must contact the e-

They must receive authorization from the e-Help Desk before filing a paper return.

THOMSON REUTERS
1120 E-FILE GUIDE



Chapter 11: Transmissions and Acknowledgments 99

Transmission Perfection Period For Rejected Returns

Rejected E-filed Extensions

If the IRS rejects the application for filing extension request, and the reason for the rejection cannot be
corrected and retransmitted, the provider must take reasonable steps to inform the taxpayer of the rejection
within 24-hours of receiving the acknowledgment. The provider must also provide the taxpayer with a Business

Rule explanation.

« Ifthe electronic application for filing extension can be retransmitted, it must be filed by the later of the due
date of the return or five calendar days after the date the Service gives notification the application for
extension is rejected.

« Ifthe electronic application for filing extension cannot be accepted for processing electronically, the

taxpayer must file a paper application for filing extension. In order for the paper application for filing
extension to be considered timely, it must be filed by the later of the due date of the filing extension or five
calendar days after the date the IRS gives notification that the filing extension is rejected. The paper
application for filing extension should include an explanation of why it is being filed after the due date and
include a copy of the electronic rejection notification.
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CHAPTER 12: STATE RETURNS

States offering e-file follow one of two methods:
« Directfiling with the state, or
o Filing through the IRS as part of the IRS MeF Fed/State Program.

Please see the 1120 State E-file Guide for the latest state information.
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CHAPTER 13: APPENDICES

APPENDIX A: ACCEPTED FORMS AND SCHEDULES

Thomson Reuters accepts for e-file the following approved forms and schedules for Forms 1120/1120S/1120-
F. The table lists the form names and the maximum number of forms that can be submitted with each return.

The forms and schedules listed at the following URL are the only forms and schedules acceptable for e-file. The
E-file Notes lists the number of forms allowable by the IRS.

https://www.riahelp.com/html/2020/reports/ef_forms/1120/1120_Federal_E-file_Forms.pdf

This document is kept current.

Exclusions from E-file

The return types listed below cannot e-filed as standalone returns at the parent level. For corporations required
to e-file that include these return types as subsidiary returns, the e-file for these corporations mustinclude
these return types in XML format.

RETURN TYPE DESCRIPTION

1120-L Life Insurance

1120-PC Property and Casualty

See the 1120 Insurance Return Guide for more information.

If any of the forms listed below are to be filed as stand-alone returns (that is, not part of a consolidated return),
they must be filed on paper since they are not currently processed on the MeF system. However, if any of the
following forms are part of a consolidated return, they can be attached in PDF format. They should be named
appropriately and attached to the top-level consolidated return.

RETURN TYPE DESCRIPTION

1120-C Farmer’s Cooperative Association
1120-FSC Foreign Sales Corporation
1120-H Homeowners Association

THOMSON REUTERS
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Appendix A: Accepted Forms and Schedules

RETURN TYPE DESCRIPTION

1120-IC DISC Interest Charge Domestic International Sales Corporation
1120-ND Nuclear Decommission Trusts

1120-REIT Real Estate Investment Trust

1120-RIC Regulated Investment Companies

1120-SF Settlement Funds

Forms 1120-C through 1120-1C-DISC (listed above) are only required to be e-filed if they are part of a
consolidated return filing. If these forms are part of a consolidated return, they should be included in PDF
format, named appropriately, and attached to the top-return level. Otherwise, they must be filed on paper since
MeF does not process them at this time.

Form 1120X cannot be filed as a stand-alone return. It can only be submitted as an attachmenttoa Form 1120
return.

RETURN TYPE DESCRIPTION

1120-X Amended Corporate Return

Exclusions to E-file

Returns and extensions with these conditions cannot be e-filed.

FORMS 1120/1120S/1120-F

« Returns covering multiple tax periods

« Bank Holding Company Tax Act - Election to make installment payments for a portion of the total tax
attributable to the Bank Holding Company Tax Act

o Prompt Assessments

THOMSON REUTERS
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Appendix B: E-file Terminology

FORM 7004 EXCLUSIONS

Name change applications

o Requests for refunds

« Applications requesting extension due to change in accounting period unless prior approval has been
applied for from IRS or certain conditions have been met. See Publication 538, Accounting Periods and
Methods.

o Applications with Net Operating Loss Carryback - Form 1138 should be sent separately, not with the
application

« Applications attaching a Power of Attorney (POA). POA should be sent separately, not with the application
« Early filed returns (filed before end of tax period)
o Filing short period extension due to termination of 1120S status
« Extensions for the following forms:
o Form 706-GS(D)
o Form 8612
o Form 8613
o Form 8725
o Form 8831

o Form 8876

APPENDIX B: E-FILE TERMINOLOGY

Acknowledgment An electronic confirmation from the IRS that a return is either accepted or rejected
Aggregation The process of combining multiple XML files into a single XML file that is transmitted to the IRS.

Alert Identifies issues with an e-filed return that the IRS feels should be brought to the attention of the taxpayer
or e-file transmitter. Thomson Reuters also generates Alerts as e-file diagnostics.

Amended Return A subsequent return filed after the expiration of the filing period (including extensions.)
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Appendix B: E-file Terminology

Authorized E-file Provider A business authorized by the IRS to participate in the IRS E-file program. An E-file
Provider can be a sole proprietorship, partnership, corporation or other entity. The business submits an
application (Form 8633), is accepted to participate, is assigned an EFIN, and receives credentials. The
business can choose more than one provider option.

Binary Attachment The binary attachment is a scanned document in PDF format that can be attached to the
electronic tax return file and e-filed as part of the tax return. The binary attachment is part of the Business Rules
Return conditions for the return to be accepted by the IRS.

Business Rules Specific conditions in the return that must be met. These rules generally insure that required
information and forms are not missing.

EFIN The Electronic Filing Identification Number is a six-digit number issued to the Electronic Return Originator
by the IRS to identify the entity as one that has been approved as an Authorized IRS E-file Provider.

ELF Electronic Filing (rights) - Individuals within the firm must have electronic filing rights in order to E-file the
return. These rights must be set up for the designated individuals by the company/firm administrator.

ERO The Electronic Return Originator originates the electronic submission of tax returns to the IRS.

ETIN The Electronic Transmitter Identification Number is a number issued to the software vendor or software
provider by the IRS to indicate that the software has been approved by the IRS for electronic filing.

General Dependency Schema Used for including the XML file information that has not been defined by other
IRS schemas.

International Member Return An 1120 subsidiary return used for preparing international forms for
aggregation with top consolidation or partnership returns. The XML file (with an XIT extension) for an
International Member Return is created from within a top consolidation return.

Large Taxpayer Alarge taxpayer, as defined by the IRS for e-file purposes, is not an Authorized IRS E-file
Provider. A Large Taxpayer is a business that prepares and transmits the electronic submission of its own
business returns directly to the IRS and either has assets of $10 million or more, or is a partnership with more
than 100 partners.

Mandated Taxpayer Partnerships with more than 100 partners, and corporations with assets of $10 million or
more and who file at least 250 returns (including income tax, information returns, excise tax, and employment
tax returns), with the IRS during the year. These taxpayers are required by the IRS to e-file their returns.

MeF Modernized e-File - An XML based system used to e-file partnership and corporate income tax returns.

Mixed Returns An 1120 consolidated tax return (1120) that includes at least one subsidiary that is either a Life
Insurance company (Form 1120-L) or a Property and Casualty Insurance company (Form 1120-PC).
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Name Control Derived from the first four characters of the taxpayer name. Used in conjunction with the
taxpayer EIN to identify the taxpayer in the IRS databases.

Practitioner PIN An 11-digit number used for signing a return. The first six positions consist of the ERO’s
EFIN, with the last five positions selected by the ERO.

Reject A condition existing in the return that prevents the IRS from accepting the e-file. The condition can result
from not following business rules or validation errors in the XML file.

Schemas An XML document that specifies the data elements, structures and rules for each form, schedule,
document, and attachment in a return.

Superseding Return A subsequent return filed within the filing period (including extensions).

Transmitter Sends the electronic return data directly to the IRS. A transmitter must have software and
computers that allow it to interface with the IRS.

Validation The process of verifying that each data element in the XML file complies with the IRS schema data
format specifications.

XML Extensible Markup Language is the programming language used for MeF.

APPENDIX C: FAQS

Preparer Tips

What are the recommended procedures for preparing an e-file?
Recommended procedures for creating your e-file:
1. Ifareturn will be e-filed, enable e-file very early in the return preparation process.

2. Ifyou have PDF attachments, , name the PDF file name per IRS naming convention, without special
characters, without multiple spaces, and without symbols.

3. Ifyou are uploading a Third Party XML, name the XML file name without special characters, without
spaces, and without symbols.

4. Asyou are working on the return, frequently create the validation file at any return level. Review and
correct e-file diagnostics and XML validation errors during the return preparation process.
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5. The Organizer screens for specific forms include instruction for e-file returns.

6. Review your e-file through the E-file Viewer.
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